
• 

Owen W. Linzmayer 

Contains 17 
Awesome 

Shareware and 
Freeware Programs 
on Disk 

• Includes Sound 
Effects, Wacky 
Custom Cursors, 
Icon Editors, 
and More 

• Suitable for Use 
with System 6 or 7 
and Almost ~,., 
AnyMac W 

SYBEX 



Icon 

'\.. ~ 

1'~-:r 
/ . 

. · :.'·.~ :·· .. 

~ 
}~0 

~18.1 

~ 
~$ 

Program Name 

Cursor Animato r 

Dylan Talk 

Fo lder Icon Maker 

Greg's Buttons 

iContraption 

Invisible Clock 

® Kingyo 

Menu Bar Pattern 

Description 

Allows you to substitute each o f the five system 
cursors (1-beam, crossha ir , crossbar, w ristwatch, and 
arrow) w ith static or animated color cursors 
guaranteed to be much more entertaining. 

A hilarious spoof on the incoherent mumblings of a 
cerra in American folk singer, DylanTalk anempts to 
pronounce the text in modal dialog and alert boxes, as 
well as the ti tles of controls w hen they are cl icked. It's 
so stupid, it's good. 

Page 

75 

19 

Makes impressive-looking custom icons for folders 67 
with a drag-and-drop interface that couldn't be simpler. 

Gives your Mac a complete make-over, aheting the 89 
def~tul t font, buttons, and background colors, among 
other things. 

A full -blow n icon editor that can also be used to move '55 
icon resources from one file to another. Comes with 
dozens upon dozens of icons. 

Aud ibly announces the time in a p leasant, female 9 
voice . Then this unpaid secretary hangs out in the 
background, announcing the time between the hours 
you choose: every hour, half-hour, or quarter-hour as 
you prefer. 

If you 've always wanted a pet but are too self­
involved to give it the love and food it craves, Kingyo 
is just w hat the vet ordered : a cute animated cartoon 
fish that swims around your screen. 

Paints the menu bar w ith incredibly cool desktop 
pauerns as large as 32 x 64 p ixels and containing 
up to 256 colors, including \Va llpaper patterns. 

103 

43 



Icon Program Name Description Page 

~ 
MenuBall Places a bouncing ball in your menu bar for absolutely 39 

no good reason. Go figure. 

1r 
Psychedel• INIT Recreates the misfiring synapses of the late 1960s by 87 

randomly changing the color of text everywhere it 
appears. 

li PuzzleTime Anyone who enjoys a good challenge will love 109 
PuzzleTime, a bigger and better version of Apple's 
Puzzle DA, in which you attempt to arrange tiles of an 
animated QuickTime movie. 

m Shutdown Slide Gracefully slides the desktop off the screen in one of 129 
several very interesting ways when you choose Shut 
Down from the Finder's Special menu. 

~ 
Snow Creates a man-made snowstorm with 13 different 119 

types of snowflakes gently drifting down the desktop 
to the nostalgic sound of sleigh bells in the 
background . 

• The Sound- Plays stunning songs in the background as you go 23 
Trecker about your work, like your own personal jukebox. So 

good, it's scary. 

D SpiN it Causes windows, dialog boxes, alert boxes (and even 115 
menus sometimes) to appear on screen after their 
outlines spin into place. 

~ 
Welcome Allows you to reposition and change the "Welcome to 3 

Macintosh" startup message to anything you like. You 
can even change the "Debugger installed" and 
"Extensions off" messages, too. 

[[I] Xmas lights Strings up a row of flashing, brightly colored lights 123 
under the menu bar, and you control the flashing 
patterns. 



Computer users are not all alike. 
Neither are SYBEX books. 

We know our customers have a variety of needs. They've told us so. And because we've listened, 
we've developed several distinct types of books to meet the needs of each of our customers. What are you 
looking for in computer help? 

If you're looking for the basics, try the ABC's series. You'll find short, unintimidating tutorials and 
helpful illustrations. For a more visual approach, select Teach Yourself, featuring screen-by-screen illustra­
tions of how to use your latest software purchase. 

Mastering and Understanding titles offer you a step-by-step introduction, plus an in-depth examina­
tion of intermediate-level features, to use as you progress. 

Our Up & Running series is designed for computer-literate consumers who want a no-nonsense over­
view of new programs. just 20 basic lessons, and you're on your way. 

We also publish two types of reference books. Our Instant References provide quick access to each 
of a program's commands and functions. SYBEX Encyclopedias and Desktop References provide a com­
prehensive reference and explanation of all of the commands, features, and functions of the subject software. 

Sometimes a subject requires a special treatment that our standard series don't provide. So you'll fmd 
we have titles like Advanced Techniques, Handbooks, Tips & Tricks, and others that are specifically 
tailored to satisfy a unique need. 

We carefully select our authors for their in-depth understanding of the software they're writing about, 
as well as their ability to write clearly and communicate effectively. Each manuscript is thoroughly reviewed 
by our technical staff to ensure its complete accuracy. Our production department makes sure it's easy to 
use. All of this adds up to the highest quality books available, consistently appearing on best-seller charts 
worldwide. 

You'll fmd SYBEX publishes a variety of books on every popular software package. Looking for com­
puter help? Help Yourself to SYBEX. 

For a complete catalog of our publications: 
SYBEX Inc. 
2021 Challenger Drive, Alameda, CA 94501 
Tel: (510) 523-8233/(800) 227-2346 Telex: 336311 
Fax: (510) 523-2373 

SYBEX is committed to using natural resources wisely to presetve and improve our environment. As a leader in the 
computer book publishing industry, we are aware that over 40% of America's solid waste is paper. This is why we 
have been printing the text of books like this ~:>neon recycled paper since 1982. 

This year our use of recycled paper will result in the saving of more than 15,300 trees. We will lower air pollution 
effluents by 54,000 pounds, save 6,300,000 gallons of water, and reduce landfill by 2,700 cubic yards. 

In choosing a SYBEX book you are not only making a choice for the best in skills and information, you are also 
choosing to enhance the quality of life for aU of us. 



This Book Is 
Only the Beginning. 

Introducing the SYBEX Forum on CompuServe®. 

It costs nothing to join the SYBEX Forum. All you have to do is access 
CompuServe and enter GO SYBEX. As a SYBEX Forum member, you'll have 
access to expert tips and hints about your computer and the most popular 
software programs. 

If you're not already a CompuServe member, try it for free toll-free, 
800·848•8199 and ask for representative #560. You'll get a personal ID num­
ber and password, one FREE month of basic service, a FREE subscription to 
CompuServe Magazine, and a $15 credit towards your CompuServe connect 
time charges. Once you're on CompuServe, simply enter GO SYBEX and start 
t ~lo~ the SYBEX Forum. 

SYBEX. Help Yourself. 
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SYBEX warrants the enclosed disk to be free of physical defects for a period of 
ninety (90) days after purchase. If you discover a defect in the disk during this 
warranty period, you can obtain a replacement disk at no charge by sending the 
defective disk, postage prepaid, with proof of purchase to: 

SYBEX Inc. 
Customer Service Department 

2021 Challenger Drive 
Alameda, CA 94501 

(800) 227-2346 
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introduction 

Ever since I wrote Totally Rad Mac Programs, I've been deluged 
with mail from readers begging me to write a sequel. Only happy 
to oblige once SYBEX ponied up the advance, I have spent 
hundreds more hours surfing the high seas of cyberspace, combing 
through the world's user group libraries, on-line databases, and 
commercial offerings in search of bitchin' programs. Now in case 
you've never heard the term before, I hasten to add that bitchin' is 
surfer lingo for mondo cool, most excellent, totally rad, buff stuff, 
like a killer wave that rolls on forever. 

It took a lot of work, but after separating the winners from the 
losers, I found 17 bitchin', productivity-sapping programs that 
deliver a second helping of dumb fun. This book is organized in 
the way you would encounter these programs as you use your Mac, 
with the programs affecting the startup process appearing first. 
These are followed by a couple of sound effects programs, two 
control panels for messing with the menu bar, a pair of applications 
for manipulating icons, and a nine-pack of files for creating miscel­
laneous mayhem. Each program is fully documented in its own 
chapter explaining what the program does, complete with detailed 
installation instructions, steps for using the program, compatibility 
notes, and information on contacting the programmers. 
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a a a a a a a installing bitchin' mac programs 
To provide the most bytes for the buck, all of the files included with 
this book are stored on a single BOOK 3V2" disk in a self-extracting, 
compressed archive. Before you can install the bitchin' programs, 
you must unstuff the archive. To do so, tum on your Mac and when 
the Finder's desktop appears, insert the enclosed disk in an empty 
drive. Double-click the disk icon to open its window, then double­
click the Programs.sea icon to launch Stufflt Lite. At the splash 
screen, click Continue to present a dialog box where you can 
specify a name and location for the Bitchin' Mac Programs folder. 
Pick a hard drive with at least 1.8 Mb of free space, then click Save. 
An alert box shows the progress as Stuffl t Lite unstuffs the files in 
the folder. If all goes well, click Quit after the alert box announces 
that the installation was successful. Once the files have been un­
stuffed, follow the detailed directions in each program's chapter for 
installing the individual files where they belong on your hard drive. 

After you install the programs as described, they may have generic 
icons. If you want your Mac to display the custom icons pictured 
in this book, you must rebuild your Desktop. The programs are 
operational as is, but it's a good idea to rebuild the Desktop peri­
odically for preventative maintenance whenever generic icons ap­
pear where they shouldn't. To rebuild the Desktop, start your Mac 
normally, but hold down the X-Option keys until the Finder asks 
if you really want to rebuild the Desktop. You do, so click OK. If 
you have more than one disk, click OK as the Finder asks about 
rebuilding the Desktop on each. The time it takes to rebuild the 
Desktop depends on the speed and size of the disk. When done, 
the Finder should no longer show generic icons for any files that 
have their own custom icons. Also, you may notice somewhat faster 
response time when starting up your Mac or quitting programs. 
The only drawback to rebuilding your Desktop is that you lose any 
Comments you may have entered into files' Get Info windows. 
Since few people use this feature, it's usually not a concern. 
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a a a a a a a a a words of warning 
This book contains optional tips on modifying programs with Res­
Edit. ResEdit is an extremely powerful utility from Apple Computer 
that allows you to change various aspects of a program's resource 
fork, the area that defines the look and feel of icons, menus, win­
dows, etc. ResEdit is free, but it's not part of the standard System 
software distributed by Apple. Since it's a rather complex utility that 
can render a file useless with a single keystroke, the best way to 
get ResEdit is bundled with a book that explains its many features. 
Always work on a copy of a file, never the original. 

With the exception of DylanTalk, Folder Icon Maker, Greg's But­
tons, iContraption, Invisible Clock, Psychedel• !NIT, PuzzleTime, 
and Xmas Lights, which require System 7, all of the programs on 
the enclosed disk have been tested for reliability and compatibility 
with System 6.0.8 and System 7.1 (if you're using earlier versions, 
you should upgrade). I'm reasonably sure that none of the 
programs contains any viruses or bugs that would in any way 
damage your Mac or its files. Still, I strongly recommend you always 
work with a current backup before trying out any new software, 
especially noncommercial programs. 

The programs are provided "as is" and technical support is not 
available. There's no guarantee that these programs will work in 
conjunction with whatever happens to be festering in the inner 
reaches of your Mac's hard drive. So use at your own risk and resist 
the temptation to load up on a mess o' programs in an attempt 
to create the coolest Mac in town. Doing so is an invitation to 
problems. Instead, use these programs judiciously, adding them 
one at a time to make sure they function properly on your Mac. 

Many of the programs included in this book are system extensions, 
also called !NITs under System 6. These are pieces of code that 
hook into the main System software, modifying the way it works. 
As such, system extensions can be extremely powerful. But if they 
are not well-behaved, system extensions can conflict with one 
another as well as other-programs that have nothing to do with the 
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System. If you've ever called a technical support hot-line, I'll bet 
you an entire royalty check that at some point you were told that 
the problem lies not with that firm's product, but rather, with the 
infamous and ever-elusive "INIT conflict." To deal with an INIT 
conflict, re-order or remove the offending file. The manual way to 
disable a system extension is to drag it out of the System folder (but 
not into the Trash), then choose Restart from the Finder's Special 
menu. But if you aspire to be a power user, get yourself a utility 
for managing system extensions. Extensions Manager is a fine 
freeware utility from Apple Computer, though I personally prefer 
using Startup Manager from Now Software. Both allow you tore­
order and disable system extensions, making it much easier to track 
down INIT conflicts. 

a a a a a a a a do the right thing 
All of the programs included on the accompanying disk appear with 
the express written permissions of their authors and publishers. 
(Obtaining unlisted phone numbers of mobsters in the Federal 
Witness Protection Program is easier than locating current addres­
ses for programmers.) All of the files were written for your enjoy­
ment by individual programmers, some of whom were gracious 
enough to place the fruits of their efforts in the public domain, 
meaning you can use and distribute their programs as you see fit. 
Many programmers retain the copyrights to their work but allow 
you to distribute their programs as long as you don't charge any­
thing (hence the nickname freeware). Others, in an attempt to jus­
tify all the time wasted writing silly little programs, have released 
their programs as shareware. That means that you can try before 
you buy. The success of the shareware concept rests on the honor 
system, so if you continue to use any shareware programs (Greg's 
Buttons, iContraption, Menu Bar Pattern, PuzzleTime, and The 
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Sound-Trecker), after a reasonable trial period of a week or two, 
please "do the right thing" and send the author whatever it is he 
has requested as a shareware fee. If you don't, we'll find out where 
you live and hunt you down like the no-good, shareware shirker 
that you are. 

a a a a a a a a a a a a a a a a keep in touch 
I love to hear comments about my books from readers like yourself, 
so feel free to contact me via electronic-mail or snail-mail (in other 
words, the U.S. Postal Service). If you'd like a personal reply, please 
include a SASE or a scratch-off lottery ticket. 

Even if you have nothing to say about the book, I would really 
appreciate it if you would drop me a postcard with your name and 
address so that I can notify you of general updates, bug fixes, 
and other special software and book offers available exclusively to 
readers such as yourself. Don't worry, I never make my database 
available to other companies or organizations because I suspect 
that you don't like junk mail any more than I do. 

Owen W. Linzmayer 
2227 15th Avenue 
San Francisco, CA 94116-1824 
AppleLink: Owen 
America Online: Owen Ink 
CompuServe: 71333,3152 
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Part 1: Startup 

The two programs covered in this section affect what you see and 
hear during the startup procedure. Welcome allows you to reposi­
tion and change the "Welcome to Macintosh" startup message to 
anything you like. You can even change the "Debugger installed" 
and "Extensions off" messages, too. Then, when the Finder's 
desktop appears, Invisible Clock audibly announces the time in a 
pleasant, female voice. This unpaid secretary hangs out in the back­
ground, announcing the time between the hours you choose: every 
hour, half-hour, or quarter-hour as you prefer. 



a m 

elcome 

Normally, when your Mac starts up, it displays the standard 
"Welcome to Macintosh" startup greeting. While it's a lot less in­
timidating than a DOS >C prompt, it has all the personality of AI 
Gore on Thorazine. Totally Rad Mac Programs contains a few gems 
that help you replace the standard "Welcome to Macintosh" startup 
greeting with any custom, full-size picture you like. While so-called 
StartupScreens are admittedly very cool, now you can also change 
the startup greeting itself using an unpretentious little program 
by the name of Welcome. 
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Welcome to Macintosh. 

Welcome to Owen's Mac II cl. 
c-~1 
c~ 

c.") 

Keep your bloody hands offl 

a a a a a a a a installing Welcome 
Welcome is an application, and as such doesn't need to go 
anyv.rhere special on your hard drive. Put it wherever you normally 
keep applications and utilities. 

a a a a a a a a a a a a a a a using Welcome 
Welcome works by editing the open System file. This causes some 
anti-viral programs to go into apoplectic fits. If that's the case on 
your Mac, either disregard the warning or temporarily disable your 
virus protection program until you're finished with Welcome. 

Even though Welcome has proven extremely reliable over the 
years, some users are apprehensive about making unnecessary 
changes to the active System file. As a precaution, make a duplicate 
of your System file before running Welcome, then drag the copy 
out of the System Folder and onto a floppy disk (if it doesn't fit on 
a floppy, just make sure this duplicate System file isn't left in the 
System Folder or the Mac could get confused the next time you re­
start). With a backup safe in hand, if something does go wrong 
while using Welcome, or your System file is corrupted at some latter 
point by unknown forces, you can always replace the bad System 
file with the fresh copy you just made. 



Welcome S 

Launch Welcome by double-clicking its icon and a dialog box dis­
plays the current Welcome message. 

Mac llci 

Welcome to Macintosh. 

To completely replace the current Welcome message, highlight it 
all and begin typing. If you want to edit the current message, posi­
tion the insertion cursor wherever you want, then Cut (3€-X), Copy 
(3€-C), and Paste (3€-V) to and from the Clipboard until you've 
composed the perfect welcome message. You can enter your 
favorite saying, a warning to scare off intruders, or perhaps iden­
tification information (a good idea for PowerBooks that might get 
lost or stolen). 

As you're thinking up clever sayings to impress your friends or dis­
gust your family, keep in mind that you can't enter special charac­
ters such as tabs, and all messages are displayed as left-justified 
text using the same 12-point Chicago font shown in Welcome's 
dialog box. 

If you need more room for your message, or you simply want to 
reposition it for aesthetic reasons, click on the small square in the 
upper left-hand corner, then resize by dragging to a new location. 
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~ Welcome to Owen's Moe II ci. 
i 

I Keep your bloody honds off!l 
i 
! 
i 

Enter up to 255 characters on eight lines in the message text field. 
Although Welcome scrolls the text field to allow you to enter more 
lines, the Mac displays only the first eight lines during startup. 

After changing the Welcome message, choose Debugger (~-2) 
from the Message menu to show the current message displayed 
when you start the Mac using a programming utility such as Macs­
Bug (if you have no idea what this means, forget this option . .. it's 
not important). As you did for the welcome message, change this 
to whatever you like. Then choose Extensions (~-3) from the Mes­
sage menu to show the current message displayed when you start 
the Mac under System 7 while holding down the Shift key to disable 
all extensions, control panels, and startup items. When called for, 
both the Debugger and Extensions messages appear at the same 
time as the Welcome message, so you should make sure they don't 
overlap. 

Just as you can reposition the various messages, you can also move 
the Mac icon by dragging it wherever you like , even on top of the 
text of the messages. Even though this icon resides as a resource 
inside the System file, you can't edit this one with iContraption (see 
chapter 7) because it's an incompatible cicn resource (ID-16396). 

When you are happy with your new messages, choose Save (~-S) 

from the File menu to make the changes permanent, or choose 
Revert from the File menu to go back to the way everything was 
the last time you saved to disk. If you want to restore the System 
file to its o rig inal status, choose Use System Default from the 
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Message menu, choose Save from the File menu, then choose Quit 
from the File menu. Finally, choose Restart from the Finder's 
Special menu to see the new startup messages in action. 

Welcome to Owen's Mac I lei. 

Keep your bloody hands off! 

Whenever you want to change the message, just launch Welcome 
again and make whatever modifications you like. 

a a a a a a a a a a a a a compatibility notes 
Welcome works under System 6 and System 7. If your Mac has a 
StartupScreen file in the System Folder, this image appears instead 
of the startup message. To see your startup message, you must 
remove the StartupScreen file from the System Folder. 

a a a a a a a a a contacting the programmer 
Welcome is freeware, copyright © 1993, Michael Carlton. Mike 
encourages you to send bug reports, suggestions, or any other 
comments (preferably via e-mail). 

Michael Carlton 
24 Breeze Avenue #4 
Venice, CA 90291-3271 
Internet: Carlton@ISI.edu 
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... ---;----, When I was growing up, my dad was a big one for playing clever 
~ J~,~ word games. "What time does the clock say?" my father would ask 
' ... JSIW me. No matter my reply, dad would laugh, "The clock doesn't say 

anything; it can't talk!" Way to go, dad, using picky semantics to 
outsmart a kid still adjusting to the disorienting concept of toilet 
training. Good thing my dad doesn't try pulling that old one on me 
today, because I'd show him Invisible Clock, a program that audibly 
announces the time. You choose every hour, half-hour, or quarter­
hour as you prefer. It's great because it takes up no room on the 
desktop or the menu bar, yet it subtly keeps you informed of 
the time using a sultry female voice. 
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Invisible Clock is an application, and as such doesn't need to go 
anywhere special on your hard drive. Put it wherever you normally 
keep applications and utilities. 

Drag Invisible Clock Sounds into the Preferences folder inside your 
System Folder. Do not drag the Invisible Clock Sounds file into 
the System Folder itself. If you do, an alert box appears explaining 
that the file belongs in the System file. Normally, this is how you 
make sound effects available to the Macintosh, but it's not what we 
want to do with Invisible Clock Sounds, so click Cancel. 

Drag Invisible Clockwork into the Startup Items folder inside your 
System Folder. Each time you turn on the computer or choose 
Restart from the Finder's Special menu, the Mac immediately 
launches the contents of the Startup Items folder in alphabetical 
order when the desktop appears. 

To temporarily prevent the Mac from launching Invisible Clock­
work, hold down the Shift key during startup until you see the 
words "Extensions disabled" below the standard "Welcome to 
Macintosh" greeting. (These messages may have been changed 
with the Welcome program, described in Chapter 1.) This tells the 
Mac not to load any extensions and not to launch any of the Startup 
Items. 

To permanently de-install Invisible Clock, remove Invisible Clock­
work from the Startup Items folder, then restart. 

a a a a a a a using Invisible Clock 
Each time you turn on the computer or choose Restart from the 
Finder's Special menu, the Mac immediately launches the contents 
of the Startup Items folder in alphabetical order when the desktop 
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appears. Since you installed Invisible Clockwork in the Startup 
Items folder, it should launch automatically and announce the time 
to the nearest quarter hour. 

If Invisible Clockwork announces the wrong time, it's probably be­
cause the Mac's internal clock is incorrectly set in either the General 
Controls or Date & Time control panel. If Invisible Clockwork 
doesn't say anything at all, it may be because it didn't find the In­
visible Clock Sounds file in the Preferences folder, or because it was 
told not to announce at startup. That option, like all others, is con­
figured using the Invisible Clock application. 

Launch Invisible Clock by double-clicking the application icon, 
then choose Start Announcing from the File menu to make sure the 
Invisible Clockwork application is turned on. 

-· I nuisible Clock 

~ I 11' is 1 L' 1 ... Preferences 
Sun Sot 

Announce Time euery ~ Quorter-Hour .,..I 
@All Doy 

0 From 9 AM until 11 PM 

0 Not this Doy 

~ Announce ot Stort 

~ Announce Doy with Time 

D Only ot Stort 

~>))-
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The Invisible Clock Preferences window is designed like a set of 
index cards, one for each day of the week. When you initially launch 
Invisible Clock, the index card for the current day automatically 
comes to the foreground. You may select any other day simply by 
clicking on its index tab. Whatever changes you make apply only 
to the selected day, unless you hold down the Option key when 
you make your selection. In that case, the change is applied to all 
days, overriding any previous settings for the individual days. I 
recommend you take advantage of this Option key shortcut to set 
all of the defaults the way you like them, then go back and tweak 
individual days if necessary. 

From the Announce Time every pop-up menu, choose how fre­
quently you'd like to hear the time: every Hour, Half-Hour, or 
Quarter-Hour. 

If you want to hear the time around the clock, click the All Day 
radio button. Conversely, if you want silence throughout the day, 
click the Not this Day radio button. And if you want an­
nouncements during only part of the day, click the middle radio 
button and in the From and Until fields, specify the hours between 
which you'd like to hear the time. For instance, enter from 9 AM 
until 5 PM for business hours only. Keep in mind that if you choose 
Announce Time Now (X-T) from the File menu, Invisible Clock an­
nounces the time regardless of these settings. 

To hear the time when Invisible Clockwork first launches, select the 
Announce at Start checkbox. This way if it's set to announce every 
60 minutes, it still announces the time even if it is not launched 
precisely on the hour. 

To hear the day as well as the time, select the Announce Day with 
Time checkbox. Most people don't need to be reminded what day 
it is (unless of course you are seriously medicated), so this may 
seem like a needless option. However, it's easy to miss the short 
time announcement, so preceding it with the day serves to notify 
you that you're about to be told the time. 
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To hear the day announced only when Invisible Clockwork ftrst 
launches, select the Only at Start checkbox. This checkbox is 
dimmed unless both the Announce Day with Time and the An­
nounce at Start checkboxes are selected. 

Use the slider on the right to specify the announcement volume. If 
set at the bottom, Invisible Clockwork uses the Speaker Volume set­
ting of the Sound control panel. Any other settings causes Invisible 
Clockwork to ignore the Sound control panel in favor of its own 
volume. 

When you are done configuring the preferences, choose Quit 
(X-Q) from the File menu to save them to the Invisible Clock Prefs 
file, which resides in the Preferences folder inside the System 
Folder. The Invisible Clock application is used only to change set­
tings; it needn't be running for you to hear the announcements. 
That is handled by Invisible Clockwork, a special type of startup 
application that works mysteriously in the background. It doesn't 
even appear in the Applications menu on the right-hand end of the 
Finder's menu bar. The only way to "quit" it is to launch Invisible 
Clock and choose Stop Announcing from the File menu. 

a a a a customizing Invisible Clock 
The Invisible Clock Sounds file contains digitized voices in snd 
resources. Using a sound editing program such as Macromedia's 
SoundEdit Pro, you can record your own voice for announcing the 
time. Just modify the existing snd resources with your voice saying 
the same phrases. 

a a a a a companion disks goodies 
The Invisible Clock Sounds file that comes with this book contains 
only enough resources to announce the time accurate to the quarter 
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hour. If you want a sounds file that can be used to announce the 
time to the minute from within the Invisible Clock application or 
via AppleEvents, see the Companion Disks Offer at the back of the 
book. 

a a a a a a a a a a a a a compatibility notes 

a a a a a 

Invisible Clock requires System 7. Invisible Clock does not work on 
the Macintosh Plus, SE, or Classic. 

a a a a contacting the programmer 
Invisible Clock is copyright© 1993, Chris Holmes. (Address with­
held by request.) 
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Part II: Sound Effects 

The two programs covered in this section show off the Mac's im­
pressive sound capabilities. A hilarious spoof on the incoherent 
mumblings of a certain American folk singer, DylanTalk attempts 
to pronounce the text in modal dialog and alert boxes, as well as 
the titles of controls when they are clicked. It's so stupid, it's good. 
On the other hand, we also have The Sound-Trecker, which is so 
good, it's scary. The Sound-Trecker is yet another quality product 
from Germany, the fatherland of fine chocolates, precision-built 
driving machines, and Cold War memorabilia. Like your own per­
sonal stereo system, The Sound-Trecker plays stunning songs in the 
background as you go about your work. You'll forget everything 
you ever thought about electronic music once you hear The Sound­
Trecker in action. 
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One summer in the mid-1980s, I shared my college apartment with 
a guy who worshipped Bob Dylan. Ben loved everything Dylan 
ever wrote. Had every album he ever recorded. Even owned a few 
books of Dylan lyrics. I read these and was impressed by the 
beautiful poetry of the words. But I'm amazed that Dylan now 
seems utterly incapable of singing the lyrics he wrote. Barbiturate 
Bob's latter-day songs sound like the incoherent ramblings of a dys­
lexic street preacher. I feel so bad for this acid-casualty I want to 
send him to night school for a diction class or to learn English as a 
second language. In the spirit of picking on washed-up celebrities 
who can't defend themselves, let me introduce DylanTalk, an ex­
tension that attempts to pronounce the text in modal dialog and 
alert boxes, as well as the titles of controls when they are clicked. 
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a a a a a a a a a a a a a a installing DylanTalk 
To install DylanTalk, just drag it into the System Folder on your 
startup volume. An alert box appears explaining that the file 
belongs in the Extensions folder. Click OK and let the Finder put it 
in the right place. 

Drag the DylanTalk Preferences folder (which contains the CB 
Teacher personality file) into the Preferences folder inside the Sys­
tem Folder (don't rename it or just drag it on top of the System 
Folder and let the Finder put it away, otherwise DylanTalk won't 
be able to locate the CB Teacher file). 

Choose Restart from the Finder's Special menu to complete the 
installation. 

To de-install DylanTalk, hold down the Shift key during startup 
until you see the words "Extensions disabled" below the standard 
"Welcome to Macintosh" greeting, then remove the extension and 
personality file from the System Folder and restart. 

a a a a a a a a a a a a a a a using DylanTalk 
You don't have to do anything to "use" DylanTalk. It kicks into gear 
automatically provided you installed everything correctly. To 
check, go to the Finder and look at the right-hand end of the menu 
bar. You should see DylanTalk's tornado icon. Pull it down and you 
should see two menu items, the first one is About DylanTalk, and 
the second one is CB Teacher with a checkmark indicating that it's 
already selected. 

Rbout Dylan Talk ... 

../ CB Teacher 
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If the tornado icon doesn't appear, check to see that the Dylan Talk 
file is in the Extensions folder and then choose Restart from the 
Finder's Special menu. If CB Teacher doesn't appear in the Dylan­
Talk menu, make sure the CB Teacher file is inside the DylanTalk 
Preferences folder, which is inside the Preferences folder, which 
resides in the System Folder (whew!). 

To test DylanTalk, double-dick the DylanTalk file or any other ex­
tension. As you would expect, the Finder presents an alert box 
explaining that extensions need to go into the Extensions folder to 
add functionality to the Mac. As the alert box appears, DylanTalk 
reads aloud the text of the alert box in a muddled voice that sounds 
like Charlie Brown's teacher. If you've never seen a Peanuts car­
toon, to you it might sound more like an announcement on the 
public address system in any mass transit waiting area. Click OK to 
dismiss the alert box and make DylanTalk shut up immediately. 

a a a a a a a companion disks goodies 
In case you were wondering, Dylan Talk gets its name from the per­
sonality file that imitates the twangy voice of folk singer Bob Dylan 
complete with incoherent words and misplaced inflections. But at 
949 kilobytes, the file was too big to include on the disk that comes 
with this book. For details on obtaining this personality file, see the 
Companion Disks Offer at the back of the book. 

a a a a a a a a a a a a a compatibility notes 
Dylan Talk requires System 7. 
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a a a a a a a a a contacting the programmer 
DylanTalk is copyright© 1992, FGM Enterprises and Dean Yu (ad­
dress withheld by request). 

Fred G. Monroe 
FGM Enterprises 
19462 Rosemarie Place #4 
Cupertino, CA 95014-3449 
AppleLink: FredM 
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J'J'' While the Mac has a well-deserved reputation as a graphics leader, 
its impressive sound capabilities often go unnoticed. PC users 
spend hundreds of dollars on SoundBlaster cards just so they can 
get a small fraction of the sound capabilities built into even the 
lowliest Mac. For my money, nothing shows off these marvelous 
capabilities in as entertaining a fashion as The Sound-Trecker, an 
application that plays beautiful-sounding songs stored in incredibly 
small files. The songs aren't digitized, yet they sound terrific, espe­
cially if you route the Mac's sound output through an amplifier, ex­
ternal speakers, or even a pair of Walkman-type headphones. 



24 Sound Effects 

a a a a a a 

a a a a a a 

On-screen controls tum your Mac into a solid-state jukebox that al­
lows you to program your favorite tracks and listen to them play 
uninterrupted in the background as you work in other applications. 
Pump up the volume, yeah pump it! 

The songs are stored efficiently in very small files sometimes called 
modules or .MOD files, but we'll call them sound tracks. There are a 
few representative sound tracks included with The Sound-Trecker, 
and there are hundreds more available in the public domain. How­
ever, music files in .MOD format are relatively unknown to the 
Macintosh community. That's because they were originally intro­
duced by SoundTracker, a similar program for the Commodore 
Amiga. You can download .MOD files from Amiga or PC bulletin 
boards and libraries, unpack them, then open them with The 
Sound-Trecker. 

a a a installing The Sound-Trecker 
The Sound-Trecker is an application, and as such doesn't need to 
go anywhere special on your hard drive. Put it wherever you nor-
mally keep applications and utilities. 

a a a a using The Sound-Trecker 
Launch The Sound-Trecker by double-clicking its icon. An alert box 
appears explaining the terms of the shareware agreement. After 
reading the agreement, click OK to close the alert box and open 
the Sound-Trecker window. 



Q 

Sound tracks: 

Q 

Ill ~ 

Display: 

The Sound-Trecker 2S 

(Background t 
Show: 

0 Oscillogram 

0 Spectrum 

®Nothing 

0 !~;~============~--------------~~~~ 
'----------~ Uolume: 111 

516928 bytes free oo:oo 
D Repeat D Shuffle 

181 Loop suppression 

D Stereo 181 Rnti alias II II 
2 3 

Frequency (kHz) 

022 016 @II 

Speed 

The Sound-Trecker window has a lot of controls that may seem 
confusing at first. For now, dick the zoom box in the upper right­
hand corner to reduce the size of the window to its most essential 
elements. You can always revert back to the larger display by click­
ing the zoom box again. 
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The scroll box at the top of the window is where all of the open 
sound tracks are displayed. Since you haven't opened anything yet, 
the scroll box is empty. Let's take care of that right now. 

Choose Open (:1€-0) from the File menu to present a standard file 
selection dialog box. 
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I 01 Sound Tracks .., I c=. Moe llci 

( Eject ) 
( Desktop ) 

( Cancel ) 

I Open , 
Locate the Sound Tracks folder on your hard disk, and keep click­
ing Open until you've selected one of the sound tracks residing in 
the folder. Only folders, sound tracks, and text files are displayed. 
Text files are displayed because that's the format .MOD files appear 
as when first copied to and decompressed on the Mac. If you at­
tempt to open an honest -to-God word processor text file by mis­
take, Sound-Trecker informs you that it isn't in the correct format. 
On the other hand, if it recognizes the file format, you have the op­
tion of converting the text file to a sound track. In most cases, this 
is what you should do. 

Instead of choosing Open from the File menu, you can double-dick 
sound track files to launch The Sound-Trecker and open the sound 
tracks automatically. And System 7 users can opt for the drag-and­
drop method: in the Finder, select all the sound track files you want 
to open and drag them onto the Sound-Trecker icon. 

Immediately upon opening a sound track, The Sound-Trecker adds 
it to the scroll box and begins playing it if no other is already play­
ing. Note that the sound track being played has a solid diamond 
next to its name. Also, the amount of free memory (in bytes) 
remaining appears below the scroll box on the left, and the running 
time (in minutes:seconds) appears on the right. If you ever need 
more memory for a really big sound track, quit The Sound-Trecker, 
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highlight its icon in the Finder, choose Get Info (:1€-1) from the File 
menu, and increase the Application/Preferred size value in the 
Memory Requirements box. 

For purposes of following along, go ahead and open another 
sound track or two now. To switch from one sound track to 
another, double-click the one you want in the scroll box, or use the 
VCR- like control buttons at the bottom of the window. 

Stop: Click this button or choose Stop (:1€- .) from the 
Miscellaneous menu to fade out and stop playing the cur­
rent sound track. The diamond next to the sound track's 
name disappears, the amount of free memory increases, 
and the running time counter resets. 

Play/Pause: If a sound track is playing, click this button 
or choose Play/ Pause (:1€-P) from the Miscellaneous 
menu to pause it immediately. The diamond next to the 
sound track's name switches from solid (playing) to hol-
low (paused) and the running time counter freezes. Click 
again to restart playing exactly where you left off. If no 
sound track is playing, click this button to load and play 
the sound track highlighted in the scroll box. If nothing 
is selected in the scroll box, a standard file selection 
dialog box appears, just as if you had chosen Open 
(:1€-0) from the File menu. 

Fast Forward: Click this button to play the current 
... sound track twice as fast as normal, or hold down the 

Option key while clicking to play four times faster than 
normal. 

Skip: Click this button or choose Skip to next piece 
.... 1 (~-+) from the Miscellaneous menu to fade out and stop 

the current sound track, then begin p laying the next 
sound track in the scroll box. If there are no sound 
tracks below the current one, The Sound-Trecker starts 
again with the one at the top of the scroll box. 
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These VCR-buttons control the most basic operations of The 
Sound-Trecker and may be all you want to bother with. However, 
there are a bunch of other options that can be controlled via check­
boxes, buttons, sliders, and menu shortcuts as follows: 

Repeat: Normally, each sound track in the scroll box is 
played once, then The Sound-Trecker stops. When this 
checkbox is selected, after playing them all, The Sound­
Trecker starts playing them over again from the top. If 
there is only a single sound track in the scroll box, it is 
played endlessly. This option may be toggled by choos­
ing Repeat on! off (X-R) from the Miscellaneous menu. 

Shuffle: Normally, sound tracks are played in the order 
in which they appear in the scroll box (which is initially 
the order in which they were opened, not alphabetical 
order). When this checkbox is selected, they are played 
in random order. To reorder manually, select a sound 
track and drag its outline to a new position in the scroll 
box, then let go of the mouse button. To make a copy of 
a sound track so that it can appear twice in the scroll 
box but not on your disk, select it and choose Duplicate 
(X-D) from the Edit menu. To remove a sound track 
altogether, select it in the scroll box and press Delete, 
choose Delete from the Edit menu, or choose Close 
(X-W) from the File menu. 

Loop Suppression: Some sound tracks don't have a 
defined end. Instead, they repeat an endless loop over 
and over. With this checkbox selected, a sound track 
with an endless loop is automatically stopped when 
that loop is reached. 

The following options affect the quality of the music and, indirectly, 
the amount of processor power required to generate the music. 
Choose Measure speed (X-G) from the Miscellaneous menu to present 
an alert box showing how much of the overall processing time is 
being used for music generation and other background processes. 
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Currently 10% of the 
processing time is used for 
music generation and other 
background processes. 

After changing a quality option (the sound output may pause for a 
short time), try measuring the speed again to see the effect the new 
setting has on the processing time used. If you run The Sound­
Trecker and nothing else, then it really doesn't matter how much 
power it consumes. However, if you want to run it in the back­
ground, the less processing time it uses, and the faster all of your 
other applications run. It's up to you to weigh the benefits of im­
proved sound quality against degraded system performance. 

Stereo: If your Mac can produce stereo sound output, 
select this checkbox to take advantage of this capability. 
You may toggle between stereo and monaural output by 
choosing Stereo on/off (X-M) from the Miscellaneous menu. 

Anti alias: Normally, sound tracks are played using a 
fast but simple sampling rate conversion algorithm that 
produces a so-called "aliasing" distortion that may be 
noticeable in some songs. If that's the case, select this 
checkbox to use a linear interpolation algorithm that 
should provide better sound quality. The drawback is 
that this option requires much more processor time. This 
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option may be toggled by choosing Anti alias on/off 
(3€-A) from the Miscellaneous menu. 

Now's a good time to click the zoom box in the upper right-hand 
corner so that we can view the Options area of the window. 

fl 
Options: 

Frequency (kHz) 

® 22 016 011 

Fine tuning (Reset) 

Pitch 

Speed 

Frequency: Click the 22, 16, or 11 kilohertz (kHz) radio 
button to switch the sampling frequency (sampling rate) 
used for sound output. The required processing power is 
proportional to the sampling rate; at 22 kHz, the number 
of calculations is twice as high as with 11 kHz. With most 
songs, the frequency does not make much difference in 
quality, especially if you use the internal speaker. So 
usually 11 kHz should be enough, but live it up at 22 
kHz if you want. 

Fine tuning: You can use the two sliders to adjust the 
playing pitch and the tempo independently by about ±50 
percent. Click Reset to return both sliders to their default 
center positions. 

The Sound-Trecker produces music by mixing four different sound 
channels, each with its own volume slider, which may be control­
led independently of the others. 
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If you want to hear only a single channel, turn off the volume for 
the other channels by clicking at the bottom of each slider. Turn 
up the volume one at a time to see how each channel affects the 
music you hear. 

If you don't hear anything, make sure the total volume slider on 
the far right hasn't been turned off completely. Normally the total 
volume should be at the halfway point. Too much higher and 
numerical ranges may be exceeded in calculations, which leads to 
clipping and a significant loss of sound quality. Conversely, when 
the total volume is too low, noise becomes more dominant. 
Remember, it's usually bette r to adjust the Speaker Volume in the 
Sound control panel rather than tweak The Sound-Trecker's total 
volume slider too much. 

In the Display section of the Sound-Trecker window, click either 
Oscillogram or Spectrum for a graphic display of the sound track 
data. According to the programmer, the frequency spectrum shows 
"the logarithmical absolute value over the linear frequency axis." 
Yeah, right. Don't ask me what the heck this stuff means .. .I'm not 
a sound wonk, but l do know that these displays look pretty cool. 
Both displays are generated in real time and may slow down low-end 
Macs with certain settings. To turn off the display, click Nothing. 
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Under System 7, click Background or choose Send to background 
(X-B) from the Miscellaneous menu to close the Sound-Trecker 
window and switch to another open application. Under System 
6.0.7 or later running MultiFinder, the Sound-Trecker window can 
be hidden by clicking a window of another application while hold­
ing down the Option key. Even though you may now be working 
in the Finder or writing in a word processor, The Sound-Trecker 
continues playing sound tracks in the background. If you want to 
change any of the settings in The Sound-Trecker, choose it from the 
Applications menu at the right-hand end of the menu bar (under 
System 7) or the Apple menu (System 6). 

After you have set up all of the options as you like them in The 
Sound-Trecker, you may want to create a configuration file that 
remembers the sound tracks in the scroll box as well as all the other 
settings. Choose Save configuration (X-S) or Save configuration as 
from the File menu to present a standard file selection dialog box. 
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Once you have saved a configuration file to disk, you can open it 
by choosing Open (X-0) or Load configuration (X-L) from the 
File menu, or you can simply double-dick it in the Finder. The 
Sound-Trecker opens the configuration file, adjusts all of the set­
tings, and updates the scroll box with all of the sound tracks that 
were open when the configuration file was saved. If any of these 
sound tracks can't be found when it's time to play them, The 
Sound-Trecker notifies you of the problem and gives you the op­
tion of locating them manually. 

Under System 7, you may want to place a configuration file (or an 
alias) in the Startup Items folder inside the System Folder. If you 
do, The Sound-Trecker automatically starts playing the sound tracks 
in the background every time you turn on or restart your Mac. 

a a a a a a a a a a companion disks goodies 
The Sound-Trecker comes with a few representative sound tracks, 
and there are hundreds more in the public domain (mostly found 
in .MOD format), but due to disk space constraints, I wasn't able 
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to include more in this book. If you'd like a handful of new sound 
tracks plus utilities to unpack Amiga and PC .MOD files, see the 
Companion Disks Offer at the back of the book. 

a a a a a a a a a a a a a compatibility notes 
The Sound-Trecker requires System 6.0.7 or later running on a 
Macintosh with a 68020 CPU or greater. The Sound-Trecker should 
be compatible with all software that conforms to the specifications 
of Inside Macintosh. Problems may arise with older software that 
uses the Sound Driver instead of the new Sound Manager. As soon 
as a program calls an old Sound Driver routine, the Sound Manager 
switches modes and stops all sound output generated via Sound 
Manager calls, including the Sound-Trecker's. When you quit the 
old program, the Sound Manager immediately restarts sound 
production. 

a a a a a a a a a contacting the programmer 
The Sound-Trecker is copyright © 1992, Frank Seide. The 
shareware fee is $30. Libraries and example source code can be ob­
tained by sending one BOOK disk, a self-addressed envelope, and 
$5 return postage. 

Frank Seide 
Wirichsbongardstr. 43 
D-52062 Aachen 
Germany 
Internet: Seide@pfa.philips.de 
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Part Ill: Menu Bar 

Totally Rad Mac Programs contains SuperApple, which replaces 
the static Apple menu icon with alternative animated icons, and 
MICN, which substitutes space-saving icons for text in the menu bar 
at the top of the screen. Bitch in' Mac Programs continues this 
proud tradition with two brand-new control panels that mess with 
the menu bar. MenuBall places a bouncing ball in your menu bar 
for no good reason, and Menu Bar Pattern applies incredibly cool 
desktop patterns as large as 32 x 64 pixels and containing up to 
256 colors. It just goes to show that not even an innocent V4 -inch 
strip of the Mac's display is safe from the frivolous hacking of deter­
mined programmers worldwide. 
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Just when you thought you had seen the stupidest Mac program 
ever, along comes MenuBall, a control panel that places a bouncing 
ball in your menu bar. For the life of me, I can't think of a more 
useless program, which is probably why it's so appealing. Who 
knows, maybe watching the ball bounce around is good practice 
for racquetball players during the off-season? Hey, wait a minute, 
racquetball is played indoors! Oh, never mind. 

a a a a a a a a a a a a a installing MenuBall 
To install MenuBall, just drag it into the System Folder on your start­
up volume. Under System 7, an alert box appears explaining that 
the file belongs in the Control Panels folder. Click OK and let the 
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Finder put it in the right place. Then choose Restart from the 
Finder's Special menu to complete the installation. 

To de-install MenuBall, hold down the Shift key during startup 
under System 7, or the X key under System 6. When the Finder ap­
pears, remove the control panel from the System Folder and restart. 

a a a a a a a a a a a a a a a a using Menu Ball 
MenuBall starts bouncing a ball in the menu bar once the Finder's 
desktop appears. Thrilling, eh? 

[ w File Edit L'j~ ••• tabel Special 

Wait, there's more. Open the MenuBall control panel by double­
clicking its icon under System 7, or choosing the Control Panel desk 
accessory from the Apple menu under System 6. 

MenuBall 
............................ 

MenuBall 
Version 2.0 

by A lex Levi Monta lcini 

@On 
QOff 

(Info) 
............................ . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

On/Off Hot Key: lcmd-opt-ctrl-b 

.................... ·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.·.· . 

D Enable gravity acceleration 

D Large ball 

D Fast bouncing 

[81 Show icon at startup 

............ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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If you want to get rid of that damn bouncing ball, click Off. You 
needn't open the control panel just to banish the ball. Instead, you 
can toggle the ball by pressing whatever key combination is set as 
the On/Off Hot Key (the default is X-Option-Control-B). 

Normally the ball bounces gracefully up and down, up and down, 
following a zig-zag path. Select the Enable gravity acceleration 
checkbox to change the way the ball bounces. With gravity 
enabled, the ball rebounds a little less on each bounce, then when 
it's just about out of spunk, it starts fresh again. 

Select the Large ball checkbox for a bigger ball. If I have to explain 
this one to you, hang it up, my friend. 

Select the Fast bouncing checkbox for a speedier ball. Keep in 
mind that the speed at which the ball bounces depends primarily 
on the power of your Mac, the types of applications you use, and 
what's going on at any given moment. For instance, when an alert 
box or dialog box is open, the ball usually bounces much faster 
than normal. 

Finally, if you want the MenuBall icon to appear along the bottom 
of the screen during startup, select the Show icon at startup check­
box. If you prefer not cluttering up your StartupScreen, deselect the 
checkbox. This checkbox affects the MenuBall icon only; the icons 
of other extensions and control panels still appear as always. 

a a a a a a a a compatibility notes 
Menu Ball works under System 6 and System 7. 
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a a a a a a a a a contacting the programmer 
MenuBall is copyright © 1993, Alessandro Levi Montalcini. If for 
some reason you actually like using MenuBall, send Alessandro a 
postcard with your comments. 

Alessandro Levi Montalcini 
C.so Re Umberto 10 
10121 Torino 
Italy 
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~ Totally Rad Mac Programs includes Before Dark, a powerful utility 
~ that replaces the Finder's default desktop patterns with incredibly 

t.::::;:;:::~:::l 

-.:r- cool ones as large as 256 pixels square and containing up to 256 
colors. But why stop at the desktop? Menu Bar Pattern allows you 
to customize the menu bar at the top of the screen with the same 
type of patterns (albeit smaller ones) used by Before Dark and 
similar programs. 

a a a a a a a a a installing Menu Bar Pattern 
To install Menu Bar Pattern, just drag it into the System Folder on 
your startup volume. Under System 7, an alert box appears explain­
ing that the file belongs in the Control Panels folder. Click OK and 
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let the Finder put it in the right place. Then choose Restart from the 
Finder's Special menu to complete the installation. 

To de-install Menu Bar Pattern, hold down the Shift key during startup 
under System 7, or the ~ key under System 6. When the Finder ap­
pears, remove the control panel from the System Folder and restart. 

a a a a a a a a a a a using Menu Bar Pattern 
Open the Menu Bar Pattern control panel by double-clicking its 
icon under System 7, or choosing the Control Panel desk accessory 
from the Apple menu under System 6. 

§Iii Menu Bar Pattern 

Menu Bar Pattern @On 
by Steve Stockman Q Off 

-
( New ) 

( Import ) 

(Duplicate ) 

( Edit ) 

( Delete ) 

( Install ) 

['8] Show icon at startup 
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Make sure Menu Bar Pattern is active by clicking On. If you want 
to temporarily disable Menu Bar Pattern without removing it from 
your System Folder, click Off. 

The scroll box in the left-hand side of the Menu Bar Pattern control 
panel shows five of the available patterns. To see the other patterns 
that are included with Menu Bar Pattern, scroll up and down by 
clicking the arrow buttons or pressing the arrow keys. When you 
see a particular pattern you like, click Install and it immediately 
covers the menu bar. Try installing the same pattern used on the 
desktop for an interesting look with only a thin black line separat­
ing the desktop from the menu items. 

If you don't find anything to your liking among the patterns in­
cluded, you can create your own. You can create an entirely blank 
pattern by clicking New, but starting with an existing pattern is 
easier. Highlight a pattern that's close to what you want, then click 
Duplicate to create a copy on which to work. To open the Edit 
dialog box, either double-dick the copy or highlight it and click Edit. 
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( Pattern Size J ( Cancel OK 

The Edit dialog box is your basic "fat bits" editor that allows you to 
change individual pixels. As you make your changes, they are 
reflected in the small preview box in the lower left-hand corner. 
Choose from the 256 different colors in the palette on the right, 
then click a pixel in the pattern to change it to the selected color. 
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IJ'I If you want to make sure you are using the same color that is al­
ready contained in the pattern, select the eye-dropper tool and 
click it on the pixel whose color you want to match. That color is 
then highlighted in the palette on the right and you can begin using 
it immediately. If you want a color that's not available, double-dick 
an unused color in the palette to present the standard Mac color 
picker. 

Select palette entry color: 

Hue 

Saturation 

Brightness 58552 

Red 58552 (;) 
Green 20489 (;) 

Blue 21047 (;) (Cancel ) ' OK » 
Select the color you want by clicking in the wheel, scrolling to ad­
just brightness, or entering numerical values in the text boxes on 
the left, then click OK to replace the old color with the new one 
you just chose. 

The pattern you are editing may not have the same dimensions as 
the examples shown in this book. That's because pattern resources 
come in many different sizes. Click Pattern Size to present a dialog 
box showing the current pattern in a variety of sizes, with its cur­
rent size highlighted. 
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8 16 32 64 
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(~ __ c_an_c_e_l~) (~ __ R_es_i_ze __ ~) 

If you want to experiment, click a different size and then click 
Resize. You can see the effect of the new size in the preview area 
of the Edit dialog box. The menu bar is usually 16 pixels tall, so the 
easiest pattern size with which to work is 16 pixels square. Al­
though some interesting effects can be generated by resizing to odd 
shapes, there's no good reason for making a pattern 64 pixels wide; 
but it's a free country, so do whatever you like. 

When you are done editing and resizing your pattern, click Cancel 
to discard your changes, or click OK to make them permanent. 

If you have some pattern resources in other files that you would 
like to use with Menu Bar Pattern, click Import to present a stand­
ard file selection dialog box. 
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I C) Startup~ I Cl Startup 

D ppats [!1 
CJ System Folder 
CJ Temporary Items 

( Eject ) 
( Desktop ) 

( Cancel ) 

~ Open ' 

Click Desktop or Drive until you locate the volume that contains 

• 

the file with the ppat (PixelPattern) resources you desire, then open 
the appropriate folders until you can double-dick the name of the 
file you want. There are always ppats in the System file if you want 
to give that a try, and you can also import patterns that work with 
Thought I Could's Wallpaper, a commercial program similar to 
Before Dark. Once you have selected a file with a ppat resource, 
an alert box displays the number of patterns that have been im­
ported into the Menu Bar Pattern file. (Patterns larger than 32 pixels 
tall and 64 pixels wide are clipped when imported, and a notifica­
tion appears to that effect.) Click OK to see the new patterns in the 
control panel. 

Each pattern you create or add to Menu Bar Pattern makes the con­
trol panel file somewhat larger. If the file ever takes up too much 
disk space, highlight a pattern that you don't like, then click Delete. 
No alert box appears asking you to confirm whether you really 
want to permanently remove the selected pattern, so be careful. 

Finally, if you want the Menu Bar Pattern icon to appear along the 
bottom of the screen during startup, select the Show icon at startup 
checkbox. If you prefer not cluttering up your StartupScreen, 
deselect the checkbox. This checkbox affects the Menu Bar Pattern 
icon only; the icons of other extensions and control panels still ap­
pear as always. 
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a a a a a a a a a a companion disks goodies 
The ppat resources used by Menu Bar Pattern are easily created 
with Apple Computer's ResEdit utility, and there are thousands of 
patterns available in the public domain. But due to disk space con­
straints, I wasn't able to include any extra patterns in this book. If 
you want more than the patterns that are built into Menu Bar Pat­
tern, you're in luck because I've assembled a wild batch of patterns 
suitable for importing into Menu Bar Pattern. For details, see the 
Companion Disks Offer at the back of the book. 

a a a a a a a a a a a a a compatibility notes 

a a a a a 

Menu Bar Pattern runs under System 6 and System 7. Menu Bar 
Pattern deactivates itself if the Monitors control panel is set to dis­
play fewer than 16 colors or grays because it would render the 
menu bar unreadable otherwise. Also, icons and other indicators 
placed in the menu bar by various programs and extensions may 
have a white border around them, but the pattern you installed 
should reappear underneath when the icons and such are no 
longer displayed. 

a a a a contacting the programmer 
Menu Bar Pattern is copyright © 1993, Steve Stockman. The 
shareware fee is $7. If you would like the source code, add $1. 
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Steve can be contacted at the following addresses: 

Steve Stockman 
Sonflower Softworks 
219 South Barrington Avenue #3 
Los Angeles, CA 90049-3324 
America Online: SonflowrSW 
AppleLink: S.Stockman 
CompuServe: 76507,2646 
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Part IV: Icons 

The two programs covered in this section are used for creating and 
editing icons. iContraption is a full-blown icon editor that can also 
be used to move icon resources from one file to another. Folder 
Icon Maker is a bit more specialized. It's sole job is to make im­
pressive-looking custom icons for folders with a drag-and-drop in­
terface that couldn't be simpler. Before playing around with either 
program, take the time to read the brief icon primer found in the 
Appendix, so that you better understand exactly what it is you can 
do with iContraption and Folder Icon Maker. When you are 
finished, you should understand the concepts of icons, resources, 
families, ID numbers, and differential calculus. All right, pay atten­
tion and I'll drop that last subject. 
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Contraption 

a 

• 

iContraption is a general-purpose color icon editor that allows you 
to view and edit just about every icon in the Mac. With almost no 
effort whatsoever, you can change the Trash into a toilet, make 
your hard disk a flying television, and turn all folders into boxes. 
You can also open boring icons and modify them any way you 
want. There's so much iContraption can do, let's get to it right away! 

a a a a a a a a a installing iContraption 
iContraption is an application, and as such doesn't need to go 
anywhere special on your hard drive. Put it wherever you normally 
keep applications and utilities. 
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a a a a a a a a a a a a a a using iContraption 
It's best to quit all other applications before launching iContraption 
so that you don't lose any important data in case something goes 
wrong. Also, since iContraption is unable to undo every type of 
modification, it's highly recommended that you always have a 
backup copy of any file you open with iContraption. 

Launch iContraption by double-clicking its icon. After displaying a 
copyright notice for a few seconds, iContraption awaits your com­
mand. Choose New (X-N) from the File menu if you want to create 
a new file to hold icon resources, or return to the Finder and drag 
an existing file onto the iContraption icon and release the mouse 
button to drop-launch. Another way to open existing files is to 
choose Open (X-0) from the File menu to present a standard file 
selection dialog box. 

Ia iControption 1.0.2 ~I 
0 I con Resources C't] 
<$ iControption 

® Files that contain I CN#'s 
0 Rll files (for custom icons) 

~Moe llci 

( Eject ) 

( Desktop ) 

c Open D 
( Cancel ) 
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For purposes of following along, open a copy of the Icon Resources 
file, which contains dozens of beautiful icons for you to use. How­
ever, for future reference, let's take a moment to explore a few of 
the other options available to you in this dialog box. 

By default, only folders and files containing at least one ICN# 
resource appear in the dialog box. If you want to edit System 7 cus­
tom icons (the kind that are pasted into Get Info windows), click 
the All files radio button to display all items (even invisible ones) 
on disk. When the All files radio button is selected, a Custom button 
appears on the right. Highlight something in the scroll box, then 
click Custom to open an Icon Picker window. If a custom icon 
(ID-16455) doesn't exist, iContraption creates one using the default 
icon. At least that's how it usually works. However, I've 
experienced crashes if a volume selected in the scroll box doesn't 
already contain a custom icon. To avoid such a nasty surprise, paste 
a placeholder custom icon into the Get Info window before trying 
to work on the custom icon with iContraption. (Why bother with 
custom icons if iContraption allows us to edit all icon families? Be­
cause custom icons don't replace other icons, so you can always 
revert back to the original icons.) 

If you have a number of files that you frequently open with 
iContraption, you can set them up to appear in the Open Special 
submenu in the File menu for easier selection. I recommend you 
do this with the Icon Resources file. Choose Open Special from the 
submenu to present a dialog box. Click Add File to open a standard 
file selection dialog box in which you can specify the files you 
want. When you click Open, the selected file appears in the Open 
Special submenu. To remove a file from the submenu, select it in 
the dialog box and click Remove File. 

Whenever you open a file with iContraption, a representative of each 
of the icon families contained therein appears in an Icon Picker 
window bearing the file name in the title bar. If you have multiple 
files open simultaneously, each has its own Icon Picker window. 
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I con Resources 

101 132 135 137 

B-®~ 
138 139 142 144 

;tX~~ 
146 147 1E11 15o 

'11tl;•ffil 
153 155 156 159 

Icon Picker windows display one representative icon for each icon 
family (to create icons from scratch, choose New Icon Family­
~-K-from the Edit menu). Any action you perform on the repre­
sentative icon applies to all members of the icon family. For 
example, beneath each representative icon is the resource ID of the 
icon family. You can easily change the resource ID for all members 
of an icon family by simply clicking on the ID and typing a new 
number (or change the number to Custom to make this the new 
custom icon for the file). If you assign a resource ID that is already 
used by another icon family in the same file, iContraption presents 
an alert box and asks you to choose another number. It's generally 
not a good idea to renumber icons within applications, extensions, 
or control panels because they use the resource ID to assign certain 
icon families to specific file types. 

Aside from renumbering the resource ID, there's much more you 
can accomplish using the Icon Picker windows. 
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To copy icon families from one file to another, Shift -click as many 
families as you like in one Icon Picker window, drag them to 
another Icon Picker window, and release the mouse button. It's just 
like using the Finder to drag files from one folder to another. An 
alert box appears momentarily to display the progress of the copy 
procedure. If the destination file already contains an icon family 
with the same resource ID as one of the families being copied, 
iContraption presents an alert box with the option to replace the 
destination icon family with the one you're dragging, assign 
a unique resource ID to the icon family (iContraption suggests a 
resource ID that won't conflict with any other icons in the destina­
tion file, but feel free to enter your own resource ID if you prefer), 
or cancel the copy procedure altogether. 

Similarly, you can easily replace one icon family for another. Just 
drag a representative icon onto the icon you want to replace until 
it is highlighted. When you drop it, the resource ID is changed auto­
matically to match that of the icon family being replaced. This 
makes changing icons a breeze. For example, open a copy of the 
System file and, one at a time, change the Trash (ID-3993) and Full 
Trash (ID-3984) icons to whatever you like using the simple drag­
and-drop procedure. The icon families in the Icon Resources file 
with ID numbers in the 500 range are designed specifically as Trash 
replacements, so give them a try. Incidentally, copies of the System 
file and the Finder are great places to locate icons that are used by 
lots of other programs. 

Finally, you can delete icon families by dragging the representative 
icons out of the Icon Picker window. An alert box appears asking 
you to confirm that you really want to permanently remove the 
selected icon families. You can also delete a family by selecting it, 
then pressing Delete or choosing Clear from the Edit menu. 



[OJ~ Icons 

Double-clicking a representative icon in the picker window opens 
the Family Portrait window for that icon family, allowing you to 
view and manipulate the individual family members. 

ID = 533 
Fro• •tcon Resources· 

EIJIJIJ 
mask 

[11 
ics8 

~ 
ics4 

[I] 
This window contains eight small boxes that represent the in­
dividual members of the icon family, which are essentially varia­
tions on a single icon optimized for viewing at different settings. 
For example , if the Finder's View menu is set to display by Small 
Icon, icons from the bottom row appear in Finder windows, but if 
the View menu is set to display by icon, icons from the top row 
appear instead. Likewise, if the Monitors control panel is set to 256 
colors, the 8-bit icons (icl8 and ics8) are used, whereas the 
monochrome icons (ICN# and ics#) are used when Monitors is set 
to Black & White. 

Double-click the member of the icon family that you wish to edit. 
For reasons that I'll explain in a moment, it's usually best to begin 

) 

with the large, 8-bit icon (icl8), although when creating icons from 
scratch, you must begin with a 1-bit icon. Once you double-click a 
member of the icon family, its contents appear in the Fatbits Editing 
window. 
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Apple Recommended Icon Colors 
• • • • ••• • 

Using the tools on the right, you can edit icons down to their in­
dividual pixels. As you make changes, they are immediately 
reflected in the preview below the toolbox. 

Before you begin editing color icons, make sure you are working 
with the desired color. If you are working on an 8-bit icon, choose 
from the palette below, which contains all 256 colors on the stand­
ard System palette, as well as a subset of 34 colors that Apple 
recommends for use when designing icons. Use whatever colors 
you like; it doesn't really matter. The currently selected color ap­
pears in a small box on the right above the palette. 
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The tools available in iContraption should be familiar to anyone 
who has ever used a Macintosh graphics program, but a brief 
refresher course can't hurt. 

Most of the detail work in the fat bits editor is done with the pencil 
tool. Click to draw and erase individual pixels, or toggle as many 
pixels as you like by holding down the mouse button. 

The eraser tool is used to erase sections of the icon. Click and drag 
to scrub out whatever portion you want to revert to white. 

The brush tool is used to draw thick swathes. It's like a big fat pen­
cil, or an eraser in reverse. 

If you want to fill in a large area with a single color, use the bucket 
tool. Position the cursor so that the bottom of the spilling paint is 
touching a pixel in the area you want to fill. When you click, 
iContraption changes the color of that pixel and all bordering pixels 
of the same color. If there's a break of even a single pixel, the buck­
et tool can inadvertently ftll a large area. Don't fret. just choose 
Undo (X-Z) from the Edit menu and try again. 

If you want to make sure you are using the same color that is al­
ready contained in the icon, select the eye-dropper tool and click 
it on the pixel whose color you want to match. That color is then 
highlighted in the palette. If you want to begin using a color 
inunediately, Option-click and the eye-dropper tool becomes the 
pencil tool. 

To draw a straight line from one pixel to another, select the line 
tool, click at the point of origin, and drag to the destination. As long 
as you are holding down the mouse button, the line is elastic, but 
once you let go, the line is drawn. If you make a mistake, you can 
always undo. 

The next three tools are used to draw ovals, rectangles with 
rounded edges, and rectangles, respectively. Only the outline of the 
object appears in the selected color; the insides are transparent and 
allow whatever is behind to show through. 
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The marquee tool is used to select portions of the icon, usually so 
that they can be manipulated with the Edit menu. For example, if 
you want to duplicate a small section, select it by dragging with the 
marquee tooL choose Copy (X-C) from the Edit menu, then choose 
Paste (X-V) from the Edit menu. The duplicate is selected, and you 
can now reposition it with the hand cursor. 

Once you have made all the changes you want, click the close box 
or choose Close (X-W) from the File menu. An alert box asks for 
confirmation of your changes, then the Family Portrait window ap­
pears with the modified icon. 

With the desired changes made to a single member of the icon 
family, it's now very easy to transfer those changes to another mem­
ber of the family. Simply click on an icon, then drag its outline onto 
another box. When you let go, iContraption automatically remaps 
colors to the closest equivalents, or if you hold down the Option 
key when you drop, iContraption uses QuickDraw's dithering 
routines to simulate a close color match. For example, when drag­
ging an 8-bit icon onto a 4-bit icon, iContraption may change cer­
tain colors if the ones used in the 8-bit icon aren't available in the 4-bit 
palette. Likewise, if you drag a large icon onto a small one, it is 
automatically scaled to fit. For best results, I find it easiest to con­
centrate most of my efforts on editing an 8-bit icon, dragging this 
to the 4 and 1-bit icons (including the mask), then dragging each 
of the large icons onto their related small icons. Once you've dupli­
cated icons in this manner, you may want to tweak the copies so 
they look as good as possible with the new size and colors. 

In most cases, you must choose Restart from iContraption's File 
menu before the new icons appear on the Finder's desktop. If they 
still don't appear, rebuild your Desktop by starting your Mac nor­
mally and pressing X-Option until the Finder asks if you really 
want to rebuild the Desktop. You do, so click OK. If you have more 
than one disk, click OK as the Finder asks about rebuilding the 
Desktop on each. The time it takes to rebuild the Desktop depends 
on the speed and the size of the disk. When done, the Finder 
should no longer show generic icons for any files which have their 
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a a a a a a 

own icons. Also, you may notice somewhat faster response time 
when starting up your Mac or quitting programs. The only draw­
back to rebuilding your Desktop is that you lose any Comments 
you may have entered into files' Get Info windows. Since few 
people use this feature anyway, it's usually not a concern. 

a a a a companion disks goodies 
iContraption comes with dozens of icons in the Icon Resources file, 
and there are thousands more in the public domain, but due to disk 
space constraints, I wasn't able to include more in this book. If 
you want more icons, see the Companion Disks Offer at the back 
of the book. 

a a a a a a a a a a a a a compatibility notes 

a a 

iContraption requires System 7 and a monitor capable of displaying 
at least 256 colors. 

a a a a a a a contacting the programmer 
iContraption was written by Brian Zuk and is copyright © 1992, 
imMedia. The shareware fee is $20. Icons supplied by Baseline 
Publishing, Doug Quinn, and Dave Schutz (Alikchi Graphics). 

If you enjoy using iContraption, you'll be pleased as punch to learn 
that it morphed into a commercial package from Baseline Publish­
ing called I Like Icon. Also, Component Software's Icon Gallery is a 
set of more than 850 color icons that can be used with iContraption. 
See the exclusive offers in the back of this book for information on 
ordering this package at substantial discounts. 



Tom Poston 
imMedia 
1910 Graybark Avenue 
Charlotte, NC 28205-3847 
America Online: TPoston 
CompuServe: 71551,2020 

Brian Zuk 
109 Rainbow Drive 
Wintersville, OH 43952-3746 
America Online: XNetZuk 
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older Icon Maker 

Even though iContraption can be used to create frivolous folder 
icons, Folder Icon Maker is a much simpler utility for replacing 
boring plain folders with custom icons. You know the type ... check 
out the icons on the System Folder or the Extensions folder. They 
look like folders with tiny icons emblazoned in the center. Creating 
these kinds of icons with Folder Icon Maker is simplicity itself, and 
it makes your desktop look so much more interesting. Once you 
get the hang of it, you'll want to change every folder you can find. 
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a a a a a a a a a installing Folder Icon Maker 
Folder Icon Maker is an application, and as such doesn't need to 
go anywhere special on your hard drive. Put it wherever you nor­
mally keep applications and utilities. You should also keep the 
gray, green, and violet folder resource files in the same folder. 

a a a a a a a a a a a using Folder Icon Maker 
The simplest way to use Folder Icon Maker is to take advantage of 
System 7's convenient drag-and-drop capability. Find an applica­
tion or document that has the icon you want to place on a folder, 
then drag the file onto the Folder Icon Maker icon (neither the file 
nor the Folder Icon Maker application can be on a floppy if you 
intend to use drag-and-drop). When the Folder Icon Maker icon is 
highlighted, drop the file by letting go of the mouse button. 

~Iii Word Folder rm~ 
2 items 381 .5 MB in disk 21.1 MB av 

• <('· 
j£ 

~ 11114'4••-Y.: >:::::f\: ' 
: ~~! ~ ....................... ''·' ... . 

Folder Icon Maker ~ 
¢1¢1 1¢1¢ \!ii 

The Folder Icon Maker application automatically launches and 
creates a new folder in the same window as the dropped file. 
Folder Icon Maker then "steals" the icon of the file you dropped, 
makes it smaller, places it on a standard folder background, and 
pastes this custom icon on the new folder. Then Folder Icon Maker 
quits and returns to the Finder, all in a matter of seconds. The new, 
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empty folder has the same name as the dropped file, with the char­
acter f appended, indicating that it's a folder. 

Word Folder l!i§ 
3 items 381 .5MB in disk 21.1 MB av 

£i] 
Microsoft 'w'ord Microsoft 'w'ord f 

Folder Icon Maker 

That's the basic operation of Folder Icon Maker in a nutshell, but 
there are several options that can be selected when you drag-and­
drop. Simply hold down one of the following keys as you drop the 
file onto Folder Icon Maker and continue holding until the program 
is fmished: 

C: Copies the custom icon to the Clipboard instead of 
creating a new folder. Once on the Clipboard, you can 
paste the custom icon into almost any Get Info window. 

F: Places the custom icon on the folder in which the 
dropped file resides instead of creating a new folder. 
Due to limitations of the Finder, if the parent folder has 
ever had a custom icon before, the new icon can't be 
installed automatically and is placed on the Clipboard in­
stead. If you want to use it, select the folder, choose Get 
Info (X-I) from the File menu, then paste the new icon 
over the old. 

T: Treats the white portion of the file's icon as 
transparent, so the color of the folder shows through 
what would be white otherwise. It's a matter of aesthetics 
whether you choose to use this option or not, but it's 
usually a good idea when using black-and-white icons. 
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A: Disables the anti-aliasing feature. Anti-aliasing is 
supposed to improve visible detail when creating small 
icons on color Macs, but I've never noticed too much 
difference. 

Under normal circumstances, Folder Icon Maker creates a custom 
icon by taking the System file's standard folder icon (ID-3999) and 
placing a small icon in the center. However, you can use alternative 

~ folder icon resources as the background instead of the standard folder 
~ icon. Included with Folder Icon Maker are three alternative back-

grounds: Gray Floppy, Green Gradient, and Violet Floppy. To use 
~ these , launch Folder Icon Maker by double-clicking its icon. 
~ Choose Select Custom Folder Icon File from the Options menu to 

present a standard file selection dialog box. 

c::J Mac II ci 

Eject ) 
Desktop ) 

D Uiolet Floppy Folder Resources 

( Cancel ) 

~ Open l 
Click Desktop or Drive until you locate the volume that contains 
the custom folder icon files you desire, then open the Folder Icon 
Maker folder and double-dick one of the available resource files. 
From now on, this is the default background used by Folder Icon 
Maker. If you want, make copies of these resource files and edit 
their icons using iContraption. 

If you ever forget what resource file you have selected, choose Find 
Current Custom File from the Options menu and the resource file 
is highlighted in the Finder.· To revert back to normal, choose Use 
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Standard Folder Icon from the Options menu. For a detailed ex­
planation of how to create your own custom backgrounds, see the 
ReadMe file on disk. 

Although Folder Icon Maker is obviously designed to create icons 
for folders, two of the alternative icon resources are well suited to 
use on floppy disks. The best way to use them is to drag-and-drop 
while holding down the C key to place the custom icon on the Clip­
board, then paste this custom icon into the Get Info window of a 
floppy disk. 

a a a a a a a a a a a a a compatibility notes 

a a a 

Folder Icon Maker requires System 7. 

a a a a a a contacting the programmer 
Folder Icon Maker is freeware copyright© 1991-1992, Gregory M. 
Robbins. Greg welcomes comments, criticisms, suggestions, and 
picture postcards of your hometown. 

If you enjoy using Folder Icon Maker, you may be interested to 
know that it has mutated into part of a commercial package, Alad­
din Desktop Tools, under the guise of Desktop Icon Maker. See the 
exclusive offer in the back of this book for information on ordering 
Aladdin Desktop Tools at a substantial discount. 

Gregory M. Robbins 
109 Crocker Avenue 
Oakland, CA 94610-1212 
AppleLink: GRobbins 
Internet: GRobbins@nails.gsfc.NASA.gov 
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Part V: Random Cool Stuff 

The nine programs covered in this section fail to conveniently fall 
into any of the other categories I arbitrarily created, so by virtue of 
that common trait alone are they thusly grouped. CursorAnimator 
allows you to substitute each of the five system cursors (1-beam, 
crosshair, crossbar, wristwatch, and arrow) with static or animated 
color cursors guaranteed to be much more entertaining. 
Psychedel• INIT recreates the misfiring synapses of the late 1960s 
by randomly changing the color of text everywhere it appears. If 
that appeals to you, you'll love giving your Mac a complete make­
over with Greg's Buttons, a control panel that alters the default font, 
buttons, and background colors, among other things. If you've al­
ways wanted a pet but are too self-involved to give it the love and 
food it craves, Kingyo is just what the vet ordered: a cute animated 
cartoon fish that swims around on your screen. Anyone who enjoys 
a good challenge will love PuzzleTime, a bigger and better version 
of Apple's Puzzle DA, in which you attempt to arrange tiles of an 
animated QuickTime movie. SpiNit is a simple little extension that 
does what its name implies: it causes windows, dialog boxes, and 
alert boxes (and even menus sometimes) to appear on screen after 
their outlines spin into place. And to put you in the holiday frame 
of mind any time of the year, check out Snow and Xmas Lights, 
which place snowflakes and blinking Christmas lights on the 
Finder's desktop. Finally, when the day is over, choose Shut Down 
from the Finder's Special menu and Shutdown Slide gracefully slides 
the desktop off the screen in one of several very interesting ways. 
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ursorAnimator 

;.s.'l.~.;::=·_·-~.· CursorAnimator is your passport to the world of animated cursors! 
j~' A::· No longer must you put up with a boring 1-beam cursor, or a worth­
Y ··· : less wristwatch. Replace these with a spinning globe, walking dog, 

a a 

beating heart, rotating apple, or whatever else you come up with. 
Cursor Animator lets you substitute each of the five system cursors 
with static or animated cursors, in color! (Technically, these are 
pointers, not cursors, but who really cares?) 

a a a a a installing CursorAnimator 
To install CursorAnimator, just drag it into the System Folder on 
your startup volume. Under System 7, an alert box appears explain­
ing that the file belongs in the Control Panels folder. Click OK and 
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let the Finder put it in the right place. Then choose Restart from the 
Finder's Special menu to complete the installation. 

To de-install CursorAnimator, hold down the Shift key during start­
up under System 7, or the 3€ key under System 6. When the Finder 
appears, remove the control panel from the System Folder and 
restart. 

a a a a a a a a a a a a using CursorAnimator 
Open the Cursor Animator control panel by double-clicking its icon 
under System 7, or choosing the Control Panel desk accessory from 
the Apple menu under System 6. 

§Iii CursorRnimator 2.0.1 

Cursor Animator 2. 0 
©1990 ,91 'w' .Plotz & A.F<tlk 

[] •def<tult• . 

~ 3D Arrow 

e) Bomb! 

e Color 'w'orld 

+ Cross 

Itt Grey Arrow 3D (do . .. 

Itt Grey Arrow 3D (up) 
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At the top of the control panel are the five standard System 
cursors: I-beam, crosshair, crossbar, wristwatch, and arrow. 
Immediately below these is a grid containing the replace­
ments used by CursorAnimator. And the large scroll box dis­
plays all of the cursors currently loaded into CursorAnimator. 
As you scroll through these, notice that some are animated 
and others static. 

The grid is where you designate the replacements to be used 
for the System cursors (for example, in the preceding figure, 
the apple replaces the wristwatch above it). The grid has five 
columns for the different types of System cursors, and two 
rows for the states of the mouse button (up and down). To 
change the appearance of any System cursor, simply drag 
the desired replacement from the scroll box to the spot in the 
grid that you want to change. To revert to an original system 
cursor, either drag a System cursor from above the grid to one 
of the corresponding spots below, or drag the gray default 
cursor from the top of the scroll box. 

Note that when you click a cursor in the scroll box, the cursor 
and its name are highlighted, indicating your selection. If you 
are curious about a cursor, either double-click the cursor in 
the scroll box, drag the cursor to the Information button (it's the 
one above the Disk button), or select the cursor and then 
click the Information button to present a dialog box with 
notes and a few editable text fields. 
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Name of the Cursor: 

jlcolor World 

Delay [Ticks]: 

Color World 
© 1991 by Alexander Felk 

may distributE? thE? cursor frE?E? of 
E?, provided that this copy right 

· n is included . Any commer-cia 1 
bution of this cursor or distribution as 

(Cancel ) (Copy Info) [ OK D 

If you like, you can rename the cursor just by editing the contents 
of the first text field. Also, if it is an animated cursor, you can 
change the speed of the animation by specifying a new Delay value, 
measured in ticks, or Y60ths of a second (entering Delay values for 
static cursors has no effect, so don't bother). The larger the number, 
the greater the delay and the slower the anjmation. Conversely, for 
a fast animation, enter a small number. Each cursor has its own 
ideal Delay value, so experiment with different numbers (1 through 
32,767) until you arrive at something you enjoy. You cannot alter 
the notes in the scroll box, but you can click Copy Info to place 
them on the Clipboard for use elsewhere. When you are done, click 
Cancel to disregard your changes, or click OK to make them stick. 
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Cursors can be imported into and exported from CursorAnimator. To 
export cursors (so that they can be edited using ResEdit, for example), 
3€-click to select all those you want to group into a single file, then 
drag to the Disk icon and a standard file selection dialog box appears 
(even though the outline of only one cursor gets dragged, rest assured 
that all of the selected cursors are exported). 

I~ Mac llci •I ~Mac llci 

D Applications Q ( Eject ) 
D Data 
~ Poa,erBook ( Desktop ) 
D System Folder 
D Temporary I terns ( New CJ) 
D Utilities 0 
Saue as: ( Cancel ) 
I EHported Cursors I K Saue l 

Enter a name and location for the cursors, and click Save. Once 
saved to disk, cursors can always be imported back into Cursor­
Animator as desired, so this is a good way to archive cursors that 
you don't use every day. 

If you have some cursor resources in other files that you would like 
to use with CursorAnirnator, click the Disk icon to present a stan­
dard file selection dialog box. 
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Dl 

lc:::J Mac llci ,..I 
D AppleShare POS 
D Applications 
D Data 
D Desktop DO 
D Desktop OF 
D Disklock.driuer 

c:::J Mac II ci 

t j(~( t 

Desktop 

( Open D 
( Done ) 

Click Desktop or Drive until you locate the volume which contains 
the file with the cursor resources you desire, then open the ap­
propriate folders until you can double-click the name of the file you 
want. Cursor Animator opens the file, imports all compatible cursors 
contained therein and returns to the file selection dialog box. Either 
continue appropriating cursors from other files, or click Done to 
return to see the new cursors in the control panel. 

If you have any cursors that you want to remove from the control panel, 
~-click to select the losers, then drag to the Trash icon and they disap­
pear forever. There is no warning, and no way to undo this procedure, 
so be careful and always keep a backup copy of the CursorAnirnator 
control panel in a safe place in case you make a big mistake. 

Click the Cursor Animator button icon (it's the one between the Disk 
and Trash buttons) to present an alert box displaying additional 
information about the control panel. In addition to this on-line 
documentation, System 7 users should feel free to resort to Balloon 
Help if needed. 



CursorAnlmator 8l 

Cursor Animator 2. 0 
®1990 ,91 ~.Plotz & A.Falk 

Cursor Animator is a Control Panel that allows 
you to replace the five standard System cursors 
(arrow, watch, text, plus, and cross-hair) with 
animated or static cursors of your choice. 

On Macintosh models with a color screen you 
can also use animated or static color cursor 
replacements. 

"Cursor Animator 2.0" is copyrighted ®1990, 
91 by ~;thelm M. Plotz and Alexander Falk. 

®1990,91 ~.Plotz & A.Falk 
« ) ( » 

Please send any correspondence (bug reports 
are welcome, too) to: 

'w'ilhelm M. Plotz 
Siedlungsstrasse 21 
A-4222 St.Georgen a.d. Gusen 
Austria I Europe 

Or contact us via electronic mail: 

Internet: K340950@edvz.uni-linz.ac.at 
Bitnet: K340950@ALIJKU11 
Applelink: FALK2 
CompuServe: 100010,501 
GEnie : F ALK2 
BIX: FALK2 
X.400: /c=at/a=ada/p=telebox/s=FALK2/ 

(setup ... J([ OK JJ 

Click the left and right arrow buttons to cycle through the various 
screens, and click OK at any point to return to the control panel. 
Before you do so, click SetUp to present a dialog box containing 
some overall preference items. 

Cursor Animator 
®1990,91 \'/.Plotz & A.Falk • Version 2.0 

Please set the startup options. l'!ote that these settinge wi II 
not take effect unti I you restart your Macintosh. Since animation 
of color cursors is very tricky, it may not work on all machines. 
In such a case, please disable the animation of color cursors. 

181 Show Startup I con 

D Disable CursorAnimator 

D Disable Color Animations 

D Use Oriuer (for safe color animation) 

Use 321<8 private memory. 

(Cancel) ([ OK )) 
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If you want the CursorAnimator icon to appear along the bottom 
of the screen during startup, select the Show Startup Icon check­
box. If the Disable Cursor Animator checkbox is selected or an error 
is encountered during installation, the icon appears crossed out 
during startup. If you prefer not cluttering up your StartupScreen, 
deselect the Show Startup Icon checkbox. This checkbox affects 
the Cursor Animator icon only; the icons of other control panels and 
extensions still appear as always. 

If you want to temporarily disable CursorAnimator without remov­
ing it from your System Folder, select the Disable CursorAnimator 
checkbox. To permanently disable Cursor Animator, remove it from 
the System Folder. 

While the techniques employed by CursorAnimator seem to work 
fine under most circumstances, the control panel relies on some un­
documented features in the Mac's System software, and as such 
might not work on all Macintosh models. If you experience 
problems with CursorAnimator on a Macintosh that supports color, 
select the Disable Color Animations checkbox. This might solve 
your problems, but it has the unfortunate side effect of displaying 
color cursors as black-and-white. Before resorting to such drastic 
measures, try selecting the Use Driver checkbox instead to see if 
that doesn't fix your problem. This tells CursorAnimator to use 
routines that are a bit more reliable. Animations may run slower 
and less smoothly, but at least they are still in color. If neither of 
these options fix your problem, you might have to do without 
CursorAnimator altogether. 

The Plus and Minus buttons at the bottom of the SetUp dialog box 
are used for adjusting the amount of memory that CursorAnimator 
sets aside to enable color animations. To ensure reliable operation, 
it's best not to set this below 32K (kilobytes). As for increasing the 
amount of memory devoted to CursorAnimator, that depends on 
your needs. In the CursorAnimator control panel, the Memory in­
dicator shows how much is currently used by the replacement cur­
sors in the grid. (The Memory indicator is only active if your 
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Macintosh supports color and the Disable Color Animations check­
box is deselected.) If a cursor doesn't stay in the grid after being 
dragged there, it needs more memory than is available. As a rule, 
if the gray bar consumes more than 75 percent of the indicator, you 
should increase the memory allocation by a small amount. After 
restarting, come back and check the Memory indicator again. Con­
tinue adjusting the memory allocation until the gray bar is roughly 
in the middle of the indicator. 

Click OK to close the SetUp dialog box after you are done changing 
the settings. In order for these settings to take effect, close the 
CursorAnimator control panel and choose Restart from the Finder's 
Special menu. 

a a a a a a a a a a a a ResEdit tips 
To design your own cursors and animations, you need ResEdit or 
a similar resource editing application. Creating your own cus­
tomized cursors and animations requires you to deal with three 
resource types: CURS resources, which contain regular black-and­
white cursors; crsr resources, which contain color cursors (including 
a black-and-white version); and acur resources, which contain the 
description of the animation (i.e. the sequence of CURS or crsr 
resources to be displayed). CursorAnimator uses the acur resources 
to determine which cursors belong together and form an anima­
tion. So even when designing a simple static cursor, you must 
create an acur resource, which contains only one cursor. 

To begin designing a new animation, create separate cursor resources 
that form the individual frames of the animation. If you are creating 
a black-and-white animation, use CURS resources. But, if you are 
creating color animations, use crsr resources only. There's no need 
to create CURS resources as well because CursorAnimator automat­
ically extracts the black-and-white version from the crsr resource 
when running on a Macintosh model that does not support color. 
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After you have designed the cursors, create a new acur resource 
entering the number of frames in the first text box and the delay 
(in ticks, or Y 60ths of a second) in the second text box. Highlight 
the 1) *****, then choose Insert New Field(s) (X-K) from the Resource 
menu. Add as many new fields as you need for all of the individual 
frames. Then tab down the empty text fields and enter the resource 
IDs of the cursors comprising the individual frames. 

Once you are done, choose Get Resource Info (X-1) from the 
Resource menu and give the new resource a name. This name ap­
pears in CursorAnimator's scroll box once you import your new 
cursor. You might want to take a look at the different examples in­
cluded with CursorAnimator to get a feeling for what else you can 
do with these resources. 

If you would like to include some additional information with your 
cursor (such as your name and any copyright notices you feel ap­
propriate), create a TEXT resource with the same ID as your acur 
resource. If you use styled text (i.e. different fonts, sizes, and styles 
of text) in your TEXT resource, the necessary style information is 
stored in a styl resource with the same ID as the TEXT resource. 

When designing new cursors and animations with ResEdit, don't 
open resources inside the CursorAnimator control panel as it 
doesn't use acur resources to represent animations. Instead, during 
the import process, acur resources are automatically transformed 
into Anim resources, which contain a more extensive description 
of animation sequences. If you want to modify cursors contained 
in CursorAnimator, export them to a separate file, then open this 
file with ResEdit. Export files contain crsr and Anim resources, but 
not acur resources, these you must create yourself. 
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a a a a a a a a a companion disks goodies 

a a a a a 

CursorAnimator comes with more than a dozen cursors, and there 
are hundreds more in the public domain, but due to disk space 
constraints, I wasn't able to include more in this book. If you have 
trouble getting your hands on cursors, chill. I've put together an 
eclectic collection of cursors suitable for use with CursorAnimator. 
For details, see the Companion Disks Offer at the back of the book. 

a a a a a a a a compatibility notes 
Cursor Animator works under System 6 and System 7. Cursor­
Animator is unable to replace non-standard cursors used by some 
applications. 

a a a a a a a a contacting the programmers 
CursorAnimator is copyright© 1990-1994, Wilhelm M. Plotz and 
Alexander Falk with all rights reserved. If you use this program, 
please send these two wild and crazy guys a picture postcard of 
your home town. 

If you enjoy using CursorAnimator, you may be interested to know 
that it has a bigger brother called FunCursors, part of Now Software's 
Now Fun! collection of ... well, fun software modules. FunCursors 
has many more cursors, sports an improved user interface, and re­
quires System 7. See the exclusive offer in the back of this book for 
information on ordering Now Fun! at a substantial discount. 
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Alexander Falk 
Ziegelofengasse 41/11 
A-1052 Wien 
Wien, A-1052 
Austria 
AppleLink: Falk 
BIX: Falk2 
CompuServe: 100010,501 
Delphi: Falk2 
GEnie: Falk2 
X.400: /c=at/a=ada/p=telebox/s=FALK2/ 

Wilhelm M. Plotz 
Siedlungsstrasse 21 
A-4222 St. Georgen a. d. Gusen 
Austria 
AppleLink: WMPlotz 
Bitnet: K340950@ALI]KU11 
Internet: K340950@edvz. uni-linz.ac.at 



a m 

sychedei•INIT 

Flashback to the drug-addled days of the late 1960s with 
Psychedel• INIT, an extension that randomly changes the color of 
text in menu titles, buttons, and various other screen elements. 
Every time an element is redrawn, such as when you scroll through 
the commands in a menu, it changes color before your very eyes, 
like an undulating sea of tie-dyes at a Grateful Dead concert. It's a 
really funky trick, but unfortunately it's impossible to depict on 
a black-and-white printed page, so you must take my word for it. 

a a a a a a a a a a installing Psychedel•l NIT 
To install Psychedel• INIT, just drag it into the System Folder on 
your startup volume. An alert box appears explaining that the file 
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a a a a a a 

a a a a a a 

belongs in the Extensions folder. Click OK and let the Finder put it 
in the right place. Then choose Restart from the Finder's Special 
menu to complete the installation. 

To de-install Psychedel• INIT, hold down the Shift key during start­
up until you see the words "Extensions disabled" below the stan­
dard "Welcome to Macintosh" greeting, then remove the extension 
from the System Folder and restart. 

a a a a a a using Psychedei•INIT 
There's nothing you can do to control what gets colorized by 
Psychedel• INIT, so be aware that it might make dimmed items ap-
pear in a color other than the gray which most people expect. So 
if you choose a command from a menu and nothing happens, it 
may be because that command is actually inactive. 

a a a a a a a compatibility notes 
Psychedel• INIT requires System 7 and a monitor set to display 
colors. 

a a a a a a a a a contacting the programmer 
Psychedel•INIT is copyright© 1992, Joe Zobkiw. 

Joe Zobkiw 
Address withheld by request. 
America Online: AFL Zobkiw 
Internet: Zobkiw@world.std.com 
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reg's Buttons 

Things a little boring around the office? Plain ol' Mac interface got 
you down? Try giving your Mac a complete make-over with Greg's 
Buttons, a control panel that lets you customize many different ele­
ments that define the Mac's user interface. It replaces the standard 
flat black-and-white push buttons, checkboxes, and radio buttons 
with tasteful three-dimensional color ones designed to complement 
the puffy windows and scroll bars in the System 7 interface. Greg's 
Buttons also lets you select the background color of dialog boxes, 
menus, and Finder windows. Finally, you can substitute one of 
several alternate fonts for the default 12-point Chicago used by the 
System for displaying text in menus, window titles, dialog boxes, 
and elsewhere. When you get done with Greg's Buttons, your Mac 
will look like nothin' anybody has ever seen before! 
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a a a a a a a a a a a installing Greg's Buttons 
To install Greg's Buttons, just drag it into the System Folder on your 
startup volume. An alert box appears explaining that the file 
belongs in the Control Panels folder. Click OK and let the Finder 
put it in the right place. Then choose Restart from the Finder's Spe­
cial menu to complete the installation. 

To de-install Greg's Buttons, hold down the Shift key during startup 
until you see the words "Extensions disabled" below the standard 
"Welcome to Macintosh" greeting, then remove the control panel 
from the System Folder and restart. 

a a a a a a a a a a a a using Greg's Buttons 
The Greg's Buttons control panel is divided up into four separate 
sections, which operate independently of one another. To switch 
between these sections, click one of the four large buttons along 
the right-hand edge of the control panel. The options pertaining to 
that section then appear so that you can make whatever changes 
you want. 

a a a a a a a a a a a a a General Preferences 
Open the Greg's Buttons control panel by double-clicking its icon. 
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Make sure Greg's Buttons is active by selecting the On checkbox. 
If you want to temporarily disable Greg's Buttons without removing 
it from your System Folder, deselect this checkbox. 

If you want the Greg's Buttons icon to appear along the bottom of 
the screen during startup, select the Show Startup Icon checkbox. 
If you prefer not to clutter up your StartupScreen, deselect the check­
box. This checkbox affects the Greg's Buttons icon only; the icons 
of other extensions and control panels still appear as always. 

If the Annoying Shareware Message checkbox is selected, every 
time Greg's Buttons loads at startup, it presents an alert box when 
the Finder's desktop appears, reminding you to pay the shareware 
fee. If you have paid the fee, deselect this checkbox. 

Normally, the tiny application, document, and folder icons in the 
Finder (the smallest size that you can select in the Views control 
panel) appear as generic black-and-white icons, even if the related 
items have custom color icons when viewed at larger sizes. Select 
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the Colorize [mini-icons] in Finder checkbox to add a dash of color 
to these normally bland elements. 

a a a a a a a a a a a a a a a a a a a Buttons 
Click the large Buttons button on the right-hand edge of the control 
panel to present several options pertaining to the look and feel of 
buttons. 

Select the System 7 Color Buttons checkbox to make all of the but­
ton options operational, or deselect the checkbox to turn all of 
them off. 

Click the type of checkbox, radio button, and push button you 
prefer, and it is surrounded by a border, indicating your choice. The 
difference between the first and third radio button dot styles is that 
the latter uses the highlight color that you can specify in the Color 
control panel. 



a a a a a 

Greg's Buttons 9 3 

Select and deselect the Embossed Push Button Titles checkbox to 
see the subtle effect it has on the text as it appears in the two 
sample push buttons above. Choose whatever setting you like best, 
hut keep in mind that when selected, some push button titles be­
come fuzzy, blocky, or blurred. 

a a a a a a a a a a a a a a a Colors 
Click the large Colors button on the right-hand edge of the control 
panel to present several options pertaining to how color is added 
to the interface. 

Select the Finder Window Color checkbox if you want to replace 
the standard white used as the background for Finder windows. If 
you don't like the default color that appears to the right, click once 
in the colored box to present the standard Mac color picker. 
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Please pick a color. 

D 
Hue (;) 

Saturation (;) 
Brightness (;) 

Red 65535 (;) 
Green 65535 (;) 

Blue 52428 (;) ( Cam~eD n OJ< 0 

Select the color you want by clicking in the wheel, scrolling to ad­
just brightness, or entering numerical values in the text boxes on 
the left, then click OK to replace the old color with the new one 
you just chose. 

When you quit from an application that modifies the System color 
palette, some Finder windows may be left with splotches of ran­
dom colors in them, but these anomalies go away as soon as the 
offending windows are re-drawn. 

The following checkbox works exactly like the Finder Window 
Color checkbox just described, but of course it affects the colors of 
the menu bar/ item backs and menu titles/ item text, which can be 
set independently. It's a damn good thing you can set these 
separately, because if you set both to the same color, you won't be 
able to read anything in the menu bar. 

If you have used another control panel (such as Aurora or Kolor) 
to color your menu bar, Greg's Buttons can't override your choice 
unless you use the other control panel to revert the menu colors 
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back to black and white. Greg's Buttons then removes the color in­
formation from the System file and substitutes its own. Also, due to 
a bug in the System software, if the Monitors control panel is set 
to display thousands of colors (16-bit mode), and you colorize your 
menus, you may encounter gibberish in the menu bar when you 
launch applications. 

When you select the Alerts and Dialog Boxes checkbox, an alert 
box appears. 

The dialog box colorization feature is known to cause 
conflicts. Some dialog boxes may have residual bits of 
white background while others may appear behind the 
menu bar. Some applications may behave oddly or 
even crash. 

Please try out this feature on your Mac. If you have 
any problems, try disabling this feature. lf thatflxes the 
conflict, try adding the offending program to the 
"Exclude Applications ... " list. 

If <DIK. 'fta.aih~llj~~Jt9!!MW! U 

Read the text in the alert box before clicking OK to proceed to as­
sign colors as you would for any of the other options. Basically, it's 
a warning that some applications might not work correctly when 
this option is selected because they assume that they are dealing 
witl1 black-and-white dialog boxes. If you find such a program, 
click Exclude Applications to present an alert box showing the ap­
plications which Greg's Buttons ignores when it comes to coloriz­
ing dialog boxes. 
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Exclude from Dialog Box Colorization: 

Microsoft Word 
Disk First Aid 
Help! 
Canvas 

The applications that appear are those known to have problems, 
so it's best not to remove them. If you have found a new offender, 
click Add to present a standard file selection dialog box where you 
can locate the problem program and add it to the list. When you are 
done adding and removing applications from the list, click OK to 
return to the Colors section of Greg's Buttons. 

For some dialog box background color choices, the text insertion 
cursor may be just barely visible because the Mac uses brain-dead 
routines to figure out a "suitable" inverse (it thinks light yellow 
shows up well against a light gray, for instance). To get around this, 
try changing the dialog box background color very slightly, and the 
inverse routine may arbitrarily pick a better color. 

a a a a a a a a a a a a a a a a System Fonts 
Click the large Change System Fonts button on the right-hand edge 
of the control panel to present an option for replacing the standard 
System font with one of your choosing. 
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Select the Substitute System Font checkbox to replace the standard 
System font of 12-point Chicago with the font specified by the 
selected radio button, or deselect the checkbox to use the default 
System font. There is no way to arbitrarily change the System font 
to anything you want; you must choose from the options shown. 
Note that this feature does not change the Fonts menu used by 
applications. Those always list the fonts currently available in the 
System. Also, this feature has nothing to do with the Views control 
panel, w hich determines the font used in Finder windows for the 
display of icon names and related information. 

When you switch System fonts, menus may not adjust to the new 
font spacing immediately, but should fix themselves when the 
menu bar is redrawn. 

Note that thin fonts, such as Helvetica 12 and Palatino 12, are il­
legible when dimmed if the Monitors control panel is set to Black 
& White . Also, Palatine 14 is a little too big to work well as a System 
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font. Push buttons may appear cramped, and text might not always 
fit properly in dialog boxes. On the other hand, this font looks great 
on large screens. 

Several programs, such as Canvas, MacWrite II, and the Alarm 
Clock DA do not bother to check the System font spacing, assum­
ing the spacing for Chicago. As a result, they do not work properly 
with substitute System fonts that have Normal Spacing. If that's the 
case, choose one of the Chicago Spacing fonts offered. You may 
notice, however, that numbers appear oddly spaced. Hey, you can't 
win 'em all. 

When you are finished making changes in Greg's Buttons, click the 
close box or press X-W to close the window and implement your 
changes. 

a a a a a a a a a a a a a compatibility notes 
Greg's Buttons requires System 7 and a color-capable Mac (in other 
words, it won't work on a Mac Plus, SE, Classic, or PowerBook 
100). It works fine when running on monochrome and gray-scale 
monitors, but the effect won't be as impressive as it is in color. 

Greg's Buttons does some serious fiddling with the Mac user inter­
face, which causes problems with some applications. In most cases, 
the fault lies not with Greg's Buttons, but rather invalid assumptions 
on the part of other programmers, or the use of non- standard 
routines and resources that Greg's Buttons can't modify. If Greg's 
Buttons causes problems on your Mac, try disabling its features 
one-by-one until the problem goes away. Most likely, the problem 
is caused by only one of the many features, and the rest of the fea­
tures work without a hitch. Here are some of the most common 
known incompatibilities: 

Alarm Clock DA: The Alarm Clock DA does not work 
properly with the Normal Spacing fonts. To fix this prob­
lem, click one of the Chicago Spacing radio buttons. 
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Apple has flXed this problem with the System 7.1 Alarm 
Clock. 

America Online: Greg's Buttons does not affect America 
Online buttons because the America Online software 
bypasses the usual button routines in favor of its own 
custom routines that look like the old style buttons while 
behaving slightly differently when pushed. 

Canvas: Due to a bug in Canvas, when the Substitute 
System Font checkbox is selected in Greg's Buttons, 
some of the menu items in Canvas may be blurred when 
you drag the mouse over them. To fix this problem, 
either deselect the Substitute System Font checkbox or 
click the Helvetica 12 (Chicago Spacing) radio button. 

Directory Assistance II: Prevents Greg's Buttons from 
colorizing the New Folder button in the Save As dialog 
box. It seems that Directory Assistance II is overriding 
the normal button drawing routines and is substituting its 
own custom black-and-white version. There's nothing to 
do about this. 

Finder 7.1.1: With Finder 7.1.1, even if the Colorize 
[mini-icons] in Finder checkbox is selected, the small 
icons appear as black-and-white. 

MacWrite II: Due to a bug in the menu drawing routines 
in Claris' MacWrite II, when the Substitute System Font 
checkbox is selected in Greg's Buttons, the menus in 
MacWrite II may refuse to pull down when you click on 
them. To fiX this problem, click one of the Chicago Spac­
ing radio buttons. If the Mac Write II's Font menu doesn't 
pull down, remove the Claris Fonts file from your System 
Folder (possibly in a subfolder named Claris) to force 
MacWrite II to reconstruct its Font menu the next time 
you launch. 

MasterJuggler: Substitute System Font doesn't function 
properly with ALSoft's Masterjuggler l.S7c or earlier. 
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a a a a a a a a 

Microsoft Graph: Because it uses its own routines and 
resources, Microsoft Graph overrides the setting of the 
System 7 Color Buttons checkbox. 

The TypeBook: When Greg's Buttons is installed, the 
TypeBook generates an error message: System Heap bit 
set: Font not loaded for the .Cambridge FOND. This is 
nothing to be concerned about, and you can disable the 
TypeBook's font error-checking using its Other Options 
dialog box (obtained by holding down the Option key 
and choosing from the File menu). 

WriteNow: Due to a bug in T/Maker's WriteNow 3.0, if 
you try to use Balloon Help for any control panel (includ­
ing Greg's Buttons) while WriteNow is running, you may 
encounter spurious help balloons flashing on and off 
while you drag the mouse over the control panel. 

a contacting the programmer 
Greg's Buttons is copyright© 1993, Gregory D. Landweber. Some 
parts copyright© 1993, Symantec Corporation since it was written 
in Think C 6.0. The shareware fee for Greg's Buttons is $15 for a 
single Mac, $10 per Mac for 2-14 Macs, and $150 for an unlimited 
site license (or UK£10, UK£6, UK£100, respectively). Checks should 
be made payable to Gregory D. Landweber, denominated either in 
U.S. dollars or British pounds sterling, and mailed to the ap­
propriate address. With your payment, please include your e-mail 
address (preferably Internet), the version number, and where you 
got your copy. 

If you prefer, you can also register on-line using CompuServe (in 
which case CompuServe gets 15% of the fee) by typing GO SWREG 
at any prompt and following the instructions to register shareware. 
The registration ID for Greg's Buttons is 1277. 
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Once you have registered, you are entitled to feel good about your­
self and to deselect the Annoying Shareware Message checkbox. 
You will not get any feedback from Greg to acknowledge receipt 
of your shareware payment. Having paid once, you need never pay 
anything again, even if Greg adds zillions of features and raises the 
shareware fee. 

Greg will gladly e-mail a BinHex'd copy of the latest version of 
Greg's Buttons to anyone who e-mails him a request. He can send 
the file to addresses on CompuServe or the Internet only; the file 
is too large to cross the gateway to America Online or Applelink. 

Gregory D. Landweber 
10 Wallingford Drive 
Princeton, NJ 08540-6428 

Gregory D. Landweber 
New College 
Oxford OXl 3BN 
England 
Internet: GDL@maths.ox.ac.uk 



a m 

ingyo 

I come from a long line of pet lovers. My grandmother worked in 
a vet's office and raised championship Russian Wolfhounds. My 
parents allowed us kids to keep cats, dogs, gerbils, hamsters, birds, 
turtles, rabbits, sea monkeys, Uncle Milton's ants, and even snakes 
as pets. And my wife and I are proud owners of two lovely, well-fed 
cats. Still, as much as I like animals, never in my life have I under­
stood the attraction of keeping pet fish in aquariums. Don't get me 
wrong, I like fish as much as the next sushi-eater ... but as pets? You 
can't pet a perch, take a walleye for a walk, or play Frisbee with a 
flounder. Hell, you can barely tell one goldfish from another. None­
theless, I love Kingyo, an animated cartoon fish that swims lazily 
around and around. 
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a a a a a a a a a a a a a a a installing Kingyo 

a a a a a a 

Kingyo is an application, and as such doesn't need to go anywhere 
special on your hard drive. Put it wherever you normally keep ap­
plications and utilities. 

a a a a a a a a a a a using Kingyo 
Launch Kingyo by double-clicking its icon. A bewildered, bug-eyed 
fish appears on the desktop in a vinyl bag, as if you just brought it 
home from the pet store. 



Kingyo ~~S 

Stare in amazement for hours (OK, maybe not hours, but at 
least a few minutes) as Kingyo blatantly bids for your affec­
tion by floating around, swimming up-side down, rolling 
over, p laying dead, and blowing a ir bubbles. If you want to 
give Kingyo a bit more room to roam, choose Large from the 
Size submenu in the Option menu . Or if you think Kingyo is 
cute enough to keep , choose Bowl from the Case submenu in 
the Option me nu. 

Don't abdicate your responsibilities as a new pet owner. Remem­
ber to feed Kingyo every once in a while. Place the cursor near 
Kingyo's mouth and the cursor changes shape. Click and a 
speech balloon appears. As your Japanese-reading friends can 
tell you, Kingyo is saying "Potato chip!" for some inexplicable 
reason. 
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Like most pet fish, Kingyo doesn't do a hell of a lot more than swim 
around and eat all day. For kicks, choose About Kingyo from the 
Apple menu. Credits appear momentarily in the bowl, then some­
thing odd happens: Kingyo swims out of the bowl and around the 
desktop. Some folks might call that a bug in the program, but to 
me, it's a feature! To put Kingyo back in the bowl, just click the fish. 
Oh yes, you can move the bowl by dragging it to another location 
on the desktop. When you want to get rid of Kingyo altogether, 
there's no need to have a Ty-D-Bol burial at sea as you would with 
a real pet fish that's outlived its usefulness, just choose Quit (3€-Q) 
from the File menu. 

a a a a a a a a a a a a a compatibility notes 
Kingyo requires System 6.0.4 or higher. 
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a a a a contacting the programmer 
Kingyo is copyright© 1991, Motohira Kajihara. No animals, real or 
imagined, were hurt in any way during the creation of Kingyo. 

Motohira Kajihara 
3477 Funatsu, Kawaguchiko-machi 
Minamitsuru-gun 
Yamanashi-ken 
Japan 401-03 
Nifty Serve: PBC00171 
SIN-NET: MOTO 
YMUG-NET: Candy®Kajihara 
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uzzleTime 

Apple includes a Puzzle desk accessory as part of the standard suite 
of System software. It's a pretty lame solid-state version of the type 
of boring game kids used to play with in the back seat during cross­
country road trips before Nintendo invented the Game Boy. 
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a a a a a a 

a a a a a a 

Apple claims the Puzzle DA helps you learn how to use the mouse 
as you slide the titles around to unscramble the puzzle. If that's so, 
and Apple isn't just satisfying the ego of the programmer, I say the 
least Apple can do is up the ante with PuzzleTime, a bigger and 
better game that challenges you to arrange tiles of an animated 
QuickTime movie! 

a a a a a a a installing PuzzleTime 
PuzzleTime is an application, and as such doesn't need to go 
anywhere special on your hard drive. Put it wherever you normally 
keep applications and utilities. 

a a a a a a a a a using Puzzle Time 
Launch PuzzleTime by double-clicking its icon and a file selection 
dialog box appears. 
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If you aren't sure of the contents of a movie, select the Show 
Preview checkbox and a small thumbnail image from the selected 
movie is displayed on the left-hand side of the dialog box. If the 
selected file doesn't contain a preview, click Create to make one 
automatically (or click Update if you want to change an existing 
preview). 

Click Desktop or Drive until you locate the volume that contains 
your QuickTime movies, then open the appropriate folders until 
you can double-click the name of the file you want. Only folders 
and QuickTime movies are shown. If the file you want doesn't ap­
pear, it's probably not in the correct file format. Due to their rela­
tively enormous size, no QuickTime movies are provided on the 
disk that comes with this book; you're going to have to get them 
yourself. 

Once you open a QuickTime movie, it automatically begins playing 
in the PuzzleTime window. 
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Your QuickTime movie is divided into 16 scrambled tiles, one of 
which is black. This is the free space that allows you to slide the 
other tiles. To slide a single tile into the free space, just click one 
of the tiles that borders the black tile . You can also slide two or 
three tiles at a time by clicking a tile that doesn't border the black 
tile, but that is in the same horizontal row or vertical column. It's 
tricky to explain in print, but experiment a little and I'm sure you'll 
get the hang of it in no time. Incidentally, if you don't like the black 
lines between tiles, choose White Border from the Puzzle menu. 

Learning the rules is simple, solving the puzzle can be damn near 
impossible since the images may keep changing rapidly (blame 
MTV for contemporary directors' fascination with jump cuts). If you 
need a little help, press the Option key to number the tiles. 

If you can manage to get all the tiles in order from 1 to 16, left to 
right, top to bottom, you win! If you give up and just want to cheat, 
choose Solve Puzzle from the Puzzle menu. PuzzleTime plays the 
movie from the beginning in normal mode. 
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Using Solve Puzzle is like sneaking a peek at the box cover of a 
jig-saw puzzle. After you have a good idea of what you are working 
with, choose Scramble Puzzle from the Puzzle menu to return to 
the challenge of organizing the tiles on your own. PuzzleTime con­
tinues looping through the same QuickTime movie over and over, 
giving you as much time as you need to solve the puzzle. After a 
while, hearing the soundtrack of the QuickTime movie repeated 
endlessly is bound to drive you insane faster than rap music, so 
choose Sound from the Puzzle menu to toggle the soundtrack on 
and off. After solving or becoming frustrated with a puzzle, you can 
start a new one by choosing Open from the File menu (3€-0) or 
quit PuzzleTime by choosing Quit from the File menu (3€-Q). 

a a a a a a a a a a a compatibility notes 
PuzzleTime requires System 7 and QuickTime. 
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a a a a a a a a a contacting the programmer 
PuzzleTime is copyright© 1992, Maverick Software. The shareware 
fee is $13. 

Mark Adams 
Maverick Software 
11215 Research Boulevard #2036 
Austin, TX 78759-4177 
America Online: MarkA38 
AppleLink: Maverick.Sft 
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D Have you ever noticed that when you double-dick a folder icon in 
the Finder, its window doesn't simply pop onto the screen from out 
of nowhere, but rather, its outline "zooms" open? Well, if you 
thought that was nifty, check out SpiNit. This little extension causes 
windows, dialog boxes, and alert boxes (and even menus, some­
times) to appear on screen with outlines spinning into place. The 
animation is really cool, but alas, like some of the other programs 
in this book, it's damn near impossible to depict on the printed page. 

Think of classic movies like Citizen Kane, in which hot-off-the­
press newspapers spin out at the camera so you can read the head­
lines that advance the plot without all the heavy-handed narration 
popular in Oliver Stone flicks. Well, SpiNit brings that effect to the 
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desktop. It takes a little longer to open windows when SpiNit is 
installed, but the spinning outline builds anticipation and drama 
more effectively than a drum roll. 

A little trivia about the bizarre capitalization of SpiNit. Before Sys­
tem 7 came onto the scene, extensions were known as !NITs (after 
their file type). Since it's an INIT that spins stuff, SpiNit seemed like 
the perfect play on words. 

a a a a a a a a a a a a a a a installing SpiNit 
To install SpiNit, just drag it into the System Folder on your startup 
volume. Under System 7, an alert box appears explaining that the 
file belongs in the Extensions folder. Click OK and let the Finder 
put it in the right place. Then choose Restart from the Finder's Spe­
cial menu to complete the installation. 

To de-install SpiNit, hold down the Shift key during startup under 
System 7, or the X key under System 6. When the Finder appears, 
remove the extension from the System Folder and restart. 

a a a a a a a a a a a a a compatibility notes 
SpiNit works under System 6 and System 7. 

a a a a a a a a contacting the programmers 
SpiNit is copyright © 1989, jonathan Gary and Bill johnson. In­
cidentally, Bill also co-authored Momentum, available in my other 
book, Totally Rad Mac Programs. Momentum allows you to 
"throw" outlined objects around the desktop, complete with a 
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bouncing sound. As you can see, Bill seems to specialize in writing 
clever little hacks with no practical purpose. Ya gotta' love a guy 
like that. 

Jonathan Gary 
4 Linwood Place 
Rochester, NY 14607-1816 
America Online: JonGary 
AppleLink: A0326 

Bill Johnson 
Pharos Technologies 
8118 Corporate Way 
Mason, OH 45040-9560 
AppleLink: D0473 
CompuServe: 72257,2064 
GEnie: W]ohnson 
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Growing up in the beautiful Garden State that is New jersey, on 
cold winter evenings my siblings and I would gather 'round the 
radio listening to the weather reports, praying for snowfall which 
would cause school closings by morning. Kids today have it easy. 
They just launch the Snow application, sit back and watch 
snowflakes gently drift down the desktop with the nostalgic sound 
of sleigh bells in the background. The only drawback to such man­
made snow is it won't get you out of taking an exam or finishing 
your book report that's due tomorrow. 
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a a a a a a a a a a a a a a a ainstalling Snow 
Snow is an application, and as such doesn't need to go anywhere 
special on your hard drive. Put it wherever you normally keep ap­
plications and utilities. 

If you want, you can make Snow launch upon startup, so that every 
time you turn on the Mac you're greeted by a peacefu l snow storm. 
Under System 7, drag Snow into the Startup Items folder inside your 
System Folder. Under System 6, put Snow anywhere you want on 
your startup volume. Click once on the Snow icon, then choose Set 
Startup from the Finder's Special menu. Click the MultiFinder radio 
button and the radio button marked Snow. This sets up the Mac so 
that each time you turn on the computer or choose Restart from the 
Finder's Special menu , Snow immediately launches when the desk­
top appears. 
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a a a a a a a a a a a a a a a a using Snow 

a a a a 

Launch Snow by double-clicking its icon. After a brief pause, thir­
teen different types of snowflakes begin drifting down your 
desktop and sleigh bells can be heard in the distance. 

Fortunately, you can tum off the bells when they cross that threshold 
between mood setting and hideous, brain-rending torture. Choose 
Sleigh Bells from the File menu to toggle the checkmark. 

When you are finished watching the weather and ready to get back 
to work, simply switch to another application and the bells stop 
and the flakes disappear as Snow retreats to the background. 
Switch back to Snow and everything picks up where you left off. 
When you want to dismiss Snow for good, choose Quit (X-Q) from 
the File menu. 

a a a a a a a a a a a a ResEdit tips 
a If you aren't satisfied with the 13 different types of 

snowflakes that come built into Snow, you can play God 
and create your own unique flakes. Use ResEdit to open 
the SIGN resource (ID 128). Choose Insert New SIGN 
(X-K) from the Resource menu to start with a blank 
slate, 16 pixels on a side. When creating new flakes, you 
must maintain a one-pixel border on all sides, otherwise 
Snow leaves all sorts of harmless messy trails on the 
desktop. If that doesn't scare you off, have fun! Keep in 
mind that you're not restricted to creating snowflakes. 
Perhaps you want to make little hearts for Valentine's 
Day, or paratroopers for Veterans' Day. Whatever floats 
your boat. 

a Snow comes with the jingle bells sound effect ready to 
go, but you can change it quite easily if you have the 
right tools and a little experience. Either create a new 
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sound resource with your favorite sound input device­
such as the built-in microphones on the newer Macs, or 
a Macromedia MacRecorder-or use a sound flle you ob­
tained from another source. Replace Snow's existing snd 
resource (ID 128) with your new sound resource. For 
best results, choose a short sound that lends itself to 
being played repeatedly, and be aware that Snow distorts 
the pitch slightly. 

a a a a a a a a a a a a a compatibility notes 
Snow works under System 6 and System 7. 

a a a a a a a a a contacting the programmer 
Snow is copyright © 1993, Dave Warker. 

If you're in the market for a personal scheduling program, check 
out Remember?, Dave's shareware package that reminds you of im­
portant occasions in your life with pop-up windows and sound. 
You can specify one-time or repeating events in a flexible format. 
It reminds you when you turn on your Mac, and at any time you 
specify before each event. Most features are user adjustable. Mac­
User gave Remember? four out of a possible five mice Ouly 1990). 
To check out the program, download it from any of the major on­
line services. If you're convinced that you want it sight-unseen, 
send Dave $25 (U.S. funds only) to cover the shareware fee and 
the materials and shipping costs. Tell him Owen sent you. 

Dave Warker 
P.O. Box 273 
Egg Harbor, NJ 08215-0273 
America Online: Dave Warker 
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mas Lights 

Based upon my own limited obsetvations, the world is divided into 
two camps: those who spend countless hours hanging elaborate 
Christmas light displays every December, and those who don't 
(either because they're too lazy or they don't practice an organized 
religion that worships the frivolous use of electrical power). It doesn't 
matter to me which camp you call home; I think you'll love Xmas 
Lights, a control panel that strings up a row of flashing, brightly 
colored lights under the menu bar. Now you can enjoy Christmas 
decorations whenever you want without incurring the scornful 
looks of neighbors who don't take kindly to the practice of leaving 
lights hanging in your front yard all year 'round. Best of all, you'll 
never again play that annoying "find the burnt-out bulb" game. 
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a a a a a a a a a a a a installing Xmas Lights 
To install Xmas Lights, just drag it into the System Folder on your 
startup volume. An alert box appears explaining that the file 
belongs in the Control Panels folder. Click OK and let the Finder 
put it in the right place. Then choose Restart from the Finder's Spe­
cial menu to complete the installation. 

To de-install Xmas Lights, hold down the Shift key during startup 
until you see the words "Extensions disabled" below the standard 
"Welcome to Macintosh" greeting, then remove the control panel 
from the System Folder and restart. 
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a a a a a a a a a using Xmas Lights 
Open the Xmas Lights control panel by double-clicking its icon. 

~l!i Hmas Li hts 

Flash Pattern : 

@ Each Ught lndividua lly 

0 A 11 Lights In Unison 

0 Light Chase 

0 Xmas Light Chaos! 

0 A 11 Patterns J In Sequence 

0 Unplugged (speeds up computer) 

( Xmas Lights Info ) 

Xmas Lights has .four basic Flash Patterns (no, there's no raincoat­
in-the-park option, you cheeky monkey) that you can choose by 
clicking the appropriate radio button: 

Each light Individually flashes each light at its own 
rate, as if it had its own internal timer. 
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All Lights In Unison turns all of the lights on and off, 
one after the other, as if a single timer controlled every­
thing. On slower Macs, this option may not look realistic 
because the lights aren't drawn fast enough; if that's the 
case, try using one of the other patterns. 

light Chase causes the lights to "chase" each other 
across the menu bar. As with All Lights In Unison, this 
option may not be too convincing on slower Macs. 

Xmas light Chaos! randomly changes the colors of in­
dividual lights every time they flash-try doing that with 
real Christmas lights! This is a good option to choose to 
quickly redraw the entire string of lights if they were 
previously obscured by another screen object such as a 
window. 

If you can't make up your mind, or you like all of the options 
equally well, click the All Patterns, In Sequence radio button to 
cycle through the four different Flash Patterns in order, with each 
one active for 30 seconds at a stretch. 

Xmas Lights requires a small amount of spare processing power 
when active. Although the speed degradation shouldn't be too 
noticeable in most applications, Xmas Lights may have trouble 
detecting how much "spare" computer power is available when 
using processor-intensive applications (such as video games) that 
involve little or no typing. If you think Xmas Lights is causing the 
Mac to act lethargically, click the Unplugged radio button to tem­
porarily turn off the lights and speed up your computer. 

To access the built-in help, click Xmas Lights Info at the bottom of 
the control panel. 
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II] ·~~~~·~·~ ... !~~.~~-~~-L.~~~~~~s Up .. ~!.~.~ ... !~~-~-~.~-~.~~·~·~·~·=- ······-··-~·~ . .L-~-~--····-·······!.~~. 
Xmas Lights is a Macintosh control panel that places flashing Christmas tree ~ 
lights under your menu bar, as if someone had strung them from the top of ~ 
your screen. The control panel allows you to choose the flash pattern. 

Xmas Lights should work on any Macintosh using System 7.0 or later; it looks 
best on a Macintosh with a color screen. To install Xmas Lights. drag it onto 
your System Folder and press "OK" when your Mac asks if you'd like it to be 
placed in the Control Panels folder. Then restart your computer. 

Xmas Lights is absolutely free! For more information, use the menu above to 
view other topics. 

([ Done ll 

All the options available in Xmas Lights are explained by the infor­
mation in the scroll box. Click on the Help Topics submenu to see 
what else is available . 

Help Topics ../What's Up With These Lights? 

Changing the Pattern 

Contacting the Hmas Light Folks 
Copyright and Credits 

Other Tiger Technologies Programs 

When you are done reading the various help topics and you want 
to return to the control panel, click Done. If you want to change 
the Flash Pattern, click the radio button of your choice (it takes ef­
fect immediately), or close the control panel to return to your work. 

To really put you in the holiday mood, try running Xmas Lights in 
conjunction with Snow, discussed in the previous chapter. 
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a a a a a a a a a a a a a compatibility notes 
Xmas Lights requires System 7. 

a a a a a a a a a contacting the programmer 
Xmas Lights is copyright © 1993, Robert L. Mathews of Tiger 
Technologies. 

Robert has written another program called Menuette, which is 
similar to the MICN control panel included in my other book, To­
tally Rad Mac Programs. Both programs replace the text titles in the 
menu bar (such as File, Edit, and Window) with nifty color icons. 
Menuette comes with icons for 100 common programs, plus you 
can create your own using ResEdit. Menuette requires System 7, 
and since it's a shareware program, you can probably get a trial 
copy from your favorite on-line service or user group. But if you're 
already convinced you want it, you can order Menuette directly 
from Tiger Technologies for only $15, which includes shipping, tax, 
and handling fees. Tiger Technologies accepts payment by credit 
card (Visa or MasterCard) or checks drawn on U.S. banks. If paying 
by credit card, you can send your order by fax or e-mail. Make sure 
you specify that you're ordering Menuette and that you heard about 
it in Bitch in' Mac Programs. 

Robert L. Mathews 
Tiger Technologies 
P.O. Box 21271 
Oakland, CA 94620-1271 
(510) 832-5000 Fax 
America Online: Tiger Tech 
AppleLink: TigerTech 
CompuServe: 72551,372 
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hutdown Slide 

1m Totally Rad Mac Programs contains Shutdown Fade, an extension 
W that causes your screen to fade to black whenever you choose Shut 

Down from the Finder's Special menu. From the same programmer 
comes Shutdown Slide, a similar extension that gracefully slides the 
desktop off the screen in one of several very interesting ways. Like 
several other programs in this book, Shutdown Slide doesn't sound 
too impressive when described in print, but just keep your eyes 
peeled when you actually see it in use. 

a a a a a a a a a a installing Shutdown Slide 
To install Shutdown Slide, just drag it into the System Folder on your 
startup volume. Under System 7, an alert box appears explaining 
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a a a a a 

that the file belongs in the Extensions folder. Click OK and let 
the Finder put it in the right place. Then choose Restart from the 
Finder's Special menu to complete the installation. 

To de-install Shutdown Slide, hold down the Shift key during ::;t.an­
up under System 7, or the 3t: key under System 6. When the Finder 
appears, remove the extension from the System Folder and restart. 

a a a a a a a using Shutdown Slide 
Once installed, Shutdown Slide does its stuff whenever you choose 
Shut Down from the Finder's Special menu. Whatever is displayed 
on screen at that time gracefully slips into the ether in one of 
several interesting exits. 



a a a a a 

a a a a a 

Shutdown Slide ~ ]~ 

When Shutdown Slide finishes, either the Mac turns itself off, or 
you see the familiar "You may now switch off your Mac safely" 
alert box. 

a a a a a a a a compatibility notes 
Shutdown Slide works under System 6 and System 7. 

a a a a contacting the programmer 
Shutdown Slide is copyright © 1990, Andrew McGeachie. If you 
like it, please send Andrew a postcard or e-mail message. Fellow 
programmers should note that if you send a self-addressed stamped 
envelope, Andrew will send you the source code for Shutdown 
Slide. 

Andrew McGeachie 
32 Dover Road 
Wellesley, MA 02181-7321 
Internet: Geech@CS.BU.edu 
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Icons are an essential Macintosh element. You see icons all over, 
but especially in the Finder on documents, applications, hard 
drives, and even the Trash. These icons are stored as resources 
within the System file and in applications, extensions, and control 
panels, but usually not documents. Document icons are stored in 
the creator application, as are icons for other related ftles. For ex­
ample, a word processor application file might contain its own icon 
as well as icons for document, dictionacy, glossary, and help files. 
Change the document icon resources inside the application, and all 
of the documents appear in the Finder with the new icon. How 
does that work? 

When you copy a program containing icons from disk to disk, the 
Finder notices that the program contains icons because the fue is 
marked with a flag called the "bundle bit," which can be toggled 
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with ResEdit. If the bundle bit is on, the Finder looks inside for 
icons; if it's off, the Finder doesn't bother. While copying, the 
Finder reads the icons and stores them in two invisible Desktop 
files that keep track of files, their icons, and the programs that 
created them. You can't edit Desktop files themselves, but as I al­
ready explained, you can change the icons in your programs, and 
the next time the Finder updates its Desktop files, your new icons 
are displayed where appropriate. 

Prior to the advent of System 7, the Finder used only black-and­
white ICN# icon resources, 32-pixels square, and life was boring. 
Then along came System 7, totally tricked out with new icon 
resource types to handle different color depths and icon sizes: 

Type Size Color Depth 

ICN# 32-pixels square 1-bit (black-and-white) 

icl4 32-pixels square 4-bit (16 colors) 

idS 32-pixels square S-bit (256 colors) 

ics# 16-pixels square 1-bit (black-and-white) 

ics4 16-pixels square 4-bit (16 colors) 

icsS 16-pixels square S-bit (256 colors) 

When all of these resources carry the same ID number, together 
they comprise an icon family. From all the resources in the family, 
the Finder picks the one designed for the settings in the Monitors 
and Views control panels. For example, when Monitors is set to 
Black & White, either the 1-bit ICN# or ics# icons are used, depend­
ing upon the Views control panel and the current View menu set­
ting. But when Monitors is set to 256 colors or more, the S-bit idS 
or icsS icons are used instead. 

In addition to the new icon resource types, System 7 also brought 
a new way to apply icons. Under System 6, there is no easy way 
to change icons without resorting to esoteric programming tools 
such as ResEdit. With System 7, anyone can add custom icons, no 
fancy tools required. Launch a graphics program, such as 



How Mac Icons Work ] 3 S 

Photoshop or the paint module in ClarisWorks, then open an image 
file you like, or create something from scratch. Select the area you 
want to use as an icon (it doesn't matter how large or small) and 
choose Copy (X-C) from the Edit menu to place a copy of the 
image on the Clipboard. Return to the Finder and click once on a 
file, folder, or disk whose icon you want to change (this tip doesn't 
work with the Trash icon). With the icon highlighted, choose Get 
Info (X-I) from the File menu. In the Get Info window, click on 
the icon in the upper left so that it is surrounded by a box, indicat­
ing that it is selected. Choose Paste (X-V) from the Edit menu to 
replace the old icon with the new one. The Mac automatically 
scales the image on the Clipboard to fit the standard icon size, and 
unbeknownst to most people, the custom icon resources (ID-16455) 
are inserted into the file. Close the window (X-W) and you're 
done. By copying and pasting custom icons between various Get 
Info windows, you can have files masquerading as one another. If 
you ever want to remove a custom icon, select the icon in the Get 
Info window and choose Clear from the Edit menu. This deletes the 
custom icon resources ID-16455. 

While cutting and pasting custom icons in the Get Info window is 
a big improvement over the way changing icons is done in System 
6, it's still a lot of work. That's where iContraption and Folder Icon 
Maker come in. iContraption is an amazing program similar to Res­
Edit in that it allows you to edit the individual icon resources and 
copy entire icon families from one file to another. Folder Icon 
Maker, on the other hand, specializes in making custom folder 
icons. With a little trial and error, I'm sure you'll figure out interest­
ing ways to create icons in iContraption and use them with Folder 
Icon Maker or vice versa. 
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Part VI: Exclusive Offers 

Several conunercial software publishers are proud to offer special 
deals exclusively to readers of Bitch in' Mac Programs. Component 
Software Industries also makes a special deal on its Icon Gallery, a 
collection of over 850 color icons. Baseline Publishing graciously 
allowed the use of iContraption and several icons in this book/disk 
combo. Now Software is confident that once you get hooked on 
CursorAnimator, you'll reach for the phone to order an improved 
version in the Now Fun! package at an unheard-of discount. Finally, 
there's an order form for my very own Companion Disks that I've 
shamelessly plugged elsewhere in this book. 



"Icon Heaven ... 
Sweet, Simple, 
Serendipitous ... 
Unbelievably 
Tempting." 

- Macworld 
(December '93) 

1·800-633-4252 
FAX: 1-609-497-4008 
CALL US NOW TO ORDER! 

* READERS OF THIS BOOK ARE 
ENTITLED TO A SPECIAL $30 
PRICE. (YOU MUST MENTION 
THIS BOOK WHEN ORDERING) 

~---------------------------, I J( Yes, rush me Icon Gallery for use with iContraption. 
I J As an owner of this book, I want to save $29.95 offlhe $59.95 list price. I 
1

1 

Send $30 plus $7 SIH to: COMPONENT SOFTWARE INDUSTRIES CORPORATION 1

1 PO Box 201, Rocky Hill, NJ 08553. Or call 1-800-633-4252. 
I FAX: 1-609-497-4008 . NJ res. please add 6'h tax. VISNMC/AMEX accepted. I 
I NAME PHONE I 
I I I ADDRESS I 

------- ST -- ZIP--- --------

• I , •t _______ EXP SIGNATURE ___ _ 



(reprinted with permission from Macworld Magazine. Dec 1993) 

The Desktop Christmas 
Cheap and cheery things to put under the Apple tree 

by David Pogue 

Can you figure out what's missing from these 
instructions for replacing an icon in System 7? 
(1) Copy a graphic to the Clipboard; (2) hilight 
an icon; (3) choose Get Info from the File 
menu; (4) click on the existing icon and paste. 

What's missing, naturally, comes before you 
even start: how you're supposed to create the 
replacement icon to begin with. We are not a ll , 
alas, Norman Rockwell. (Well , many of us 
aren't even Jackson Pollack.) Even icon-editing 
programs are useless if you're talent-free. 

Enter the simple, sweet, serendipitous con­
cept of Icon Gallery (list $59.95, $38* direct 
from Component Software Industries 609/497-
450 I). It's 850 professionally painted color 
icons. People, appliances, logos, plants, 
design-disk upon disk of them (see " Icon 
Heaven"). They're enfoldered by category, 
almost universally usable, and unbelievably 
tempting. Within 30 seconds, you can make 
your landscape of files and folders more per­
sonal, more colorful, and funnier. 

(Review reprimed in its emirety: 
ordering information on reverse side) 

* READERS OF THIS BOOK ARE 
ENTITLED TO A SPECIAl $30 PRICE. 
CAlL 1·800·633·4252 TO ORDER. 
(YOU MUST MENTION THIS BOOK 
WHEN ORDERING) 

(Techie note: Each icon in this collection is 
actually a RcsEdit resource file containing the 
large, small , color, and black-and-white ver­
sions of that icon. If you are handy with 
ResEdit, therefore, you can slap these icons 
even on System 6 files, or install them penna­
nently in your own files instead of using the 
Get Info method.) 

28 items 171 .3 MS in disk 

~ 
Ball Cap Boat Load Brush 

~ a 
C•ndy Cant Catolanttrn Cokt® 

-;u.'tt- . • • ~ ,~ 
Dra9on Fact to Fact Fr099y Kni9ht 

j! ~ 
Lucky Clovtr Palm Puktr Tub 

m 
Star Storms Sushi Thumbs Up 

l l 
Snoozt Stop Shuffit 

Icon Heaven The lucky recipients of Icon Gallery can have a 
different hard drive icon every day for 2.3 years. if they are so 
inclined. 



Special Offer for Bitchin· 
Mac Programs Readers! 

Now Software is offering readers of Bitchin' Mac Programs the chance 
to customize your Mac with Now Fun!™ for a totally bitchin' price of 
only $24.95! 

Now Fun! makes your Mac wild, colorful, and downright fun with this 
fascinating array of 30 screen savers, 30 custom colors schemes, 60 
animated cursors (which includes an updated version of Cursor 
Animator), 40 vibrant desktop images, and over 100 outrageous sounds. 

Now Fun! only $24.95! 
J\1ail or Fax your order to: 

Now .'!,'t~ftware, Inc., 921 S. W. Washington St., Ste. 500, Portland, OR 97205, Fax 503.274Ji390 

r-------------------------------1 
I I 
I 

Name Special Total I 

I Organization 

I 
I Street Addre.'l.'l for P..m:el Delivery 

I City State/Province Zip Code/Postal Code 

~~~----------~-------------1 Business Phone Home 

$24.95 
*Shippin~ & H11nd/in~ (U.S. UPS Gmund) 

Total Due 
I 
I 

DMasterCard DvtSA DAMEX Dcheck (Payable to Now Software) I 

Credit Card Number (or check number) 

Signature 

I 
Expir.&tion Date I 

I 
I 

I I 
1 Country Bitchin' Mac I 

L * $6 per smgle ~t ~3 per~ form~-~ o~rs in US an~~ single~it~$4~ per unit fo~ulti-u~r~" ~ Ca~du~a.~ ~a~i._] 



Companion Disks Offer 
Each of the programs included on the Bitchin' Mac Progratns disk is ready to use as is. 
For instance, Invisible Clock comes with its basic sound file, DylanTalk has the CB 
Teacher personality file, The Sound-Trecker is bundled with a few rockin' sound tracks, 
Menu Bar Pattern includes ten pretty patterns, iContraption is loaded with more than 50 
icon families, and Cursor Animator contains well over a dozen color cursors. But that's 
just the tip of the iceberg. Look what else you can get: 

* An extended sound file making Invisible Clock accurate to the minute * 70 more icons for use with iContraption and Folder Icon Maker * Utilities and 10 more songs for use with The Sound-Trecker * The hilarious Bob Dylan personality file for DylanTalk * 40 more patterns for use with Menu Bar Pattern * 20 more cursors for use with Cursor Animator * Updates and bug fixes as needed 

All this and more is included on two 800-kilobyte, 3.5-inch companion disks stuffed to 
the gills with high-quality files suitable for use with Bitchin' Mac Progra1ns. Order now! 

--------------------------------D Yes, please send me the Bitchin' Mac Companion Disks! 
I've enclosed $5* cash, check, or money order (purchase orders, COOs, and 
credit cards not accepted) to cover materials, shipping, and handling. 

D No thanks, but keep me informed of updates and other special offers. 

Company ______________________ __ 
Name _______________________ _ 

Address ______________ __ 
City ___________ _ 

State _____________ __ 
ZIP ___________ _ 

Country _____________ __ 

~~OWEN INK 
2227 15TH AVENUE 

SAN FRANCISCO, CA 
94116-1824 

* For orders from outside the United States, please add $2 to cover additional 

L~~!~~~~~~~!~~~~!~~~~~!~~~~~-----~~ 
(If you don't want to cut up your book, mail a copy of this page or simply write the necessary information on another piece of paper.) ~ 



MAKE THE MOST OF YOUR MAC. 

300 pp./SBN·/318-4. 

T he Macintosh is supposed to be 

one of the easiest computers to 

use. But even the Mac has its prob­

lems. That's when it's time to reach 

for Murpfw's ~of Jt!hcs. This 

simple, plain-English, problem­

solving book gives you the answers 

you need and lets you have fun in 

the bargain. 

Whether you're new to com­

puters or just new to the Mac, you'll 

find a gold mine of useful informa­

tion in this book. Learn how to buy a 

Macintosh computer, find the best 

programs for your Mac, get tips for 

avoiding Mac pitfalls and more. 

You '11 get all of this and more 

in an entertaining and easy-to­

reference format. The Mac is a fun 

machine to use. Murpfw's Lau:s of 

lJ!hcs he) ps you get more from your 

Macintosh. 

SYBEX. Help Yourself. 

2021 Challenger Drive 
Alameda, CA 94501 
1-510-523-8233 
1-800- 227-2346 



A SYSTEMATIC APPROACH 
TO THE MAC. 

ISO pp. ISBN: 12 78-1. 

F ind out everything you need to 

know about System 7.1, the 

Mac's feature-rich operating system. 

T his is the first book to give you 

authoritative, expert coverage of 

advanced System 7.1 topics, while 

covering the basics for beginners. 

Start with a step-by-step primer 

for starting up the Macintosh Finder 

and control system. Then move on to 

intermediate features, like multi­

tasking and font management. You'll 

also find in-depth coverage of memo­

ry management, Inter-Application 

Communication and more. 

Advanced Mac users will 

appreciate learning about Finder 

Desktop customization; QuickTime, 

for multimedia applications; and At 

Ease, the finder alternative. Every­

thing you need is right here. 

SYBEX. Help Yourself. 

2021 Cllalieng3r Drive 
Alameda, CA 94501 
1-510-523-8233 
1- 800-227- 2346 



SYSTEM 7. 1 IN THE PALM 
OF YOUR HAND. 

300 pp. ISBN: 1277-3 

M aci11tosh System 7.1 at Your 

Fit~gertips is a no-nonsense 

guide to every feature and function of 

System 7.1 for the Mac. Even if 

you've never used a Mac before, 

you'll find the answers you need in 

this palm-sized book. 

This handy guide gives you a 

concise description of new System 7.1 

features and capabilities and a com­

prehensive overview of the operating 

system. What's more, this book is 

organized by important features and 

cross-referenced for ease of use. 

Whether you're a Mac maven 

or mortal, you'll get everything you 

need in this book-at you fingertips. 

Make sure this book is at your side 

every time you sit down at your 

Macintosh. 

SYBEX. Help Yourself. 

2021 Challeng_er Drive 
Alameda, CA 94501 
1-5 10-523-8233 
1-800-227-2346 



Help Yourself with 
Another Quality Sybex Book 

Available 
at Better 
Bookstores 
Everywhere 

The Mac Book of Excel 4 
Marvin Bryan 

This comprehensive guide to spread­

sheet power on the Mac offers en­

gaging, hands-on treatment of every 

aspect of the software. Look for 

dozens of practical examples, high­

lighted coverage of new features, 

and in-depth discussion of advanced 

techniques-along with details on 

database management, presentation 

graphics, macros, and more. 

650pp; 71/2' X 9' 
ISBN: 0-7821-1108-4 

Sybex Inc. 
2021 Challenger Drive 
Alameda, CA 94501 
Telephone (800) 227-2346 
Fax (510) 523-2373 

Sybex. Help Yourself. 



A COMPLETE GUIDE TO 
QUARKXPRESS FOR THE MAC. 

525 pp. ISBN: 1043-6. 

P age Design with QuarkXPress 3.2 

for the Mac is a thoroughly 

practical guide to this sophisticated 

page layout program. You'll find 

logical, easy-to-follow coverage of 

everything from Quark.XPress funda­

mentals to advanced features. 

Start with step-by-step instruc­

tions for creating your first QuarkX­

Press document. Then learn about 

layout templates, word processing, 

typography and graphics. You'll even 

learn about pre-press color separation. 

You'll also find complete 

descriptions of more than 100 com­

mercial and shareware QuarkX­

Tensions for a wide assortment of 

applications. 

SYBEX. Help Yourself. 

2021 Challenger Drive 
Alameda, CA 94501 
1-510-523-8233 
1-800-227-2346 



THE QUICKEST WAY 
TO LEARN QUICKTIME. 

380pp. /SBN.·JJSB-0. 

T mQuickTtmeHow-To &ok is 

a comprehensive introduction 

to multimedia desktop presentation 

with QuickTime-one of the most 

talked about and least understood 

developments in Mac computing 

today. 

The QuidlTtme How-To &ok 
gives you a solid guide to multimedia 

fundamentals, step-by-step treat­

ment of Quick Time features and a 

complete introduction to real-world 

principles to creating presentations 

for business and other uses. 

As an added bonus, this book 

includes a FREE disk packed with 

samples of each of the different 

QuickTime media types. This high­

density disk includes three Quick­

Time movies, two sound-only 

movies, two full-screen images and 

two animations, specially designed 

for you to edit as you like. 

SYBEX. Help Yourself. 

2021 Challenger Drive 
Alameda, CA 94501 
1-800-227-2346 



PRACTICAL TIPS ABOUT MAC 
PAGE DESIGN. 

525 pp. ISBN: 1171-8. 

P ageMaker 5.0 for the Mac Page 

Design is the graphic designer's 

guide to getting the most out of 

PageMaker. This friendly handbook 

will give beginners and experienced 

users alike hands-on instruction for 

PageMaker for the Mac. 

T his book starts with a basic 

overview of the program, complete 

with hands-on examples. Then 

coverage moves on to text and graphics, 

timesaving tips and print production. 

U pgraders will get an overview 

of the differe nces between Page­

Maker 4.2 and 5.0 and experts will 

find the special section on program 

shortcuts and electronic design 

resources especially useful. 

SYBEX. He lp Yourself. 

2021 Challenger Drive 
Alameda, CA 94501 
1-510-523-8233 
1-800-227-2346 



YOUR GUIDE TO A WORLD 
OF CONVENIENCE. 

321 pp. ISBN 798-3. 

F inally there's a guide that helps 

you fulfill the promises of com­

puter convenience you've always 

heard about -Exploring the »Vrld of 

Online Setvict:5. 

With the help of this book, you 

can discover the myriad conve­

niences you can enjoy by using your 

computer and a modem. Find out 

how to send electronic mail and 

messages, or tap into over 5,500 

public online databases. Get money­

saving advice for choosing modems 

and communication software, and for 

saving money on your online bills. 

Online veterans will especially 

enjoy the in-depth coverage of 

WinCIM, the new Windows version 

of the CompuServe Information 

Manager (CIM), and the in-depth 

discussion of a range of online service 

providers. 

SYBEX Help Yourself. 

2021 Challenger Drive 
Alameda, CA 94501 
800-227-2346 



Bitchin' Mac Programs 

GET A FREE CATALOG JUST FOR EXPRESSING YOUR OPINION. 
Help us improve our books and get a fREE full-color catalog in the bargain. Please complete this form, pull out this 

page and send it in today. The address is on the reverse side. 

Name Company 

Address City State Zip 

Phone ( 

1. How would you rata the overall quality 4. Where did you buy this book? 0Both 

of this book? 
0 Bookstore chain 

DOther 

DExcellent 0 Small independent bookstore 10. What kind of computer equipment do 
OVery Good 0 Computer store you have? (Check all that apply) 
DGood 0 Wholesale club 

0 PC Compatible Desktop Computer DFair 0 College bookstore 
0 Below Average DTechnical bookstore 

0 PC Compatible Laptop Computer 

DPoor OOther 
0 Apple/Mac Computer 
0 Apple/Mac Laptop Computer 

2. What were the things you liked most 5. How did you decide to buy this DCDROM 
about the book? (Check all that apply) particular book? DFaxModem 

DPace 0 Recommended by friend 
DData Modem 

DFormat Oscanner 

0 Writing Style 
0 Recommended by store personnel Osound Card 

DExamples 
0 Author's reputation 00ther 
0 Sybex's reputation 

0 Table of Contents 0 Read book review in 11. What other kinds of software packages 
Dlndex 
DPrice 

OOther do you ordinarily use? 

0 Illustrations 6. How did you pay for this book? 
DAccounting 

0Type Style DDatabases 

Ocover 0 Used own funds DNetworks 

0 Depth of Coverage 0 Reimbursed by company DApple/Mac 

0 Fast Track Notes 0 Received book as a gift 0 Desktop Publishing 

3. What were the things you liked lssst 1. What is your level of experience with 
0 Spreadsheets 
DeAD 

about the book? (Check all that apply) the subiect covered in this book? 
OGames 

DPace DBeginner 0 Word Processing 
DFormat 0 Intermediate 0 Communications 
0 Writing Style 0Advanced 0 Money Management 
DExamples 8. How long have you been using a 00ther 
DTable of Contents computer? 
Dlndex 12. What operating systems do you 

OPrice years ordinarily use? 

0 Illustrations months Ooos 
0Type Style 

9. 
OOS/2 

OCover Where do you most often use your OWindows 
0 Depth of Coverage computer? 

DApple/Mac 
0 Fast Track Notes OHome OWindowsNT 

OWork DOther 



13. On what computer-related subject(s) would you like to see more books? 

14. Do you have any other commen1s about this book? (Please feel free to use a separate piece of paper if you need more room) 

SYBEX INC. 
Department M 
2021 Challenger Drive 
Alameda, CA 
94501 

D 



The enclosed BOOK 3Y2" disk contains all of the programs covered in this book in a self­
extracting, compressed archive. Before you can install the bitchin' programs, you must un­
stuffthe archive. To do so, turn on your Mac and when the Finder's desktop appears, insert 
the enclosed disk in an empty drive. Double-dick the disk icon to open its window, then 
double-dick the Programs.sea icon to launch Stufflt Lite. At the splash screen, click Con­
tinue to present a dialog box in which you can specify a name and location for the Bitchin' 
Mac Programs folder. Pick a hard drive with at least 1.8 Mb of free space, then click Save. 
An alert box shows the progress as Stufflt Lite unstuffs the files in the folder. If all goes 
well, click Quit after the alert box announces that the installation was successful and the 
following files should appear in the Bitchin' Mac Programs folder: 

• CursorAnimator • Psychedel• INIT 

• DylanTalk • PuzzleTime 

• Folder Icon Maker • Shutdown Slide 

• Greg's Buttons • Snow 

• iContraption • The Sound-Trecker 

• Invisible Clock • SpiNit 

• Kingyo • Welcome 

• Menu Bar Pattern • Xmas Lights 

• MenuBall 

Once these files have been unstuffed, follow the detailed directions in each program's 
chapter for installing the individual files where they belong on your hard drive. In general, 
all applications can be launched from within the Bitchin' Mac Programs folder, whereas 
control panels and system extensions should be copied into the System Folder for proper 
use. You may have to choose Restart from the Finder's Special menu for the installation 
to take effect. 

After installing the programs as described, they have generic icons. If you want your Mac 
to display the custom icons pictured in this book, you must rebuild your Desktop. The 
programs are operational as is, but it's a good idea to rebuild the Desktop periodically for 
preventative maintenance whenever generic icons appear where they shouldn't. To 
rebuild the Desktop, start your Mac normally, but press X-Option until the Finder asks if 
you really want to rebuild the Desktop. You do, so click OK. If you have more than one 
disk, click OK as the Finder asks about rebuilding the Desktop on each. The time it takes 
to rebuild the Desktop depends on the speed and size of the disk. When done, the Finder 
should no longer show generic icons for any files which have their own custom icons. 
Also, you may notice somewhat faster response time when starting up your Mac or quitting 
programs. The only drawback to rebuilding your Desktop is that you lose any Comments 
you may have entered into files' Get Info windows. Since few people use this feature 
anyway, it's usually not a concern. 





Bitchin' Mac Programs 
More mondo cool stuff from the author of Totally Rad Mac Programs 

Bitchin' Mac Programs is a new collection 
of way cool freeware and shareware for 
your Mac. You get 17 awesome programs, 
plus easy-to-follow installation instructions, 
customization tips, and compatibility notes. 
Inside, you'll find: 

• Spectacular sound effects. Get your 
Mac to play totally cool music; audibly 
announce the time; and pronounce 
dialog box text in an incoherent, mum­
bling voice - as only Bob Dylan could! 

• Excellent cursor and icon editors. Lose 
those tired system cursors and icons! The 
cursor animations library includes beating 
hearts and spinning globes; the icon 
collection supplies toilet bowls, waste 
baskets, nuclear dump sites, and more. 

TM '-f;·1rect:t r: • ... t ... .,. . .. 

There's much more - including programs 
you won't find in any other book- plus 
exclusive offers for valuable discounts 
on commercial programs. All programs 
are System 7 -compatible; most also run 
under System 6. All work with almost 
any Mac, including Performa, PowerBook, 
Quadra, and Centris models. 

Why spend hours surfing cyberspace 
trying to find these programs on your 
own? Get the buff stuff right here, with 
Bitchin' Mac Programs. 

This book Includes on BOOK componlon 
disk that decompresses to 1.8 megabytes 
of start-up programs, sound effects, 

menu bar control panels, leon editors, ond other 
mlscellaneous cool stuff to make your Mac the 
hippest computer on the bloclc. 

The Sound-Trecker Snow & Xmas Ught:s Greg's Buttons 

About the Author: Owen W. Linzmayer is a San 
Frandsco-based freelance writer who contributes 
regularly to MacUser and Macworld magazines. He 
has held editorial positions at a number of personal 
computer publications, and is the author of several 
other books on video games and the Madntosh, 
including Totally Rad Mac Programs, from SYBEX. 
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Owen W. Linzmayer 

• Contains 17 
Awesome 

Shareware and 
Freeware Programs 
on Disk 

• Includes Sound 
Effects, Wacky 
Custom Cursors, 
Icon Editors, 
and More 

• Suitable for Use 
with System 6 or 7 
and Almost 
Any Mac 



Icon 

-... " '-r~ . .._ 
/ . 

·'::'· ... :·· . . 

~ 
r Go 
I i[&l 

~ 
~~ 

Program Name 

Cursor Animator 

Dylan Talk 

Folder Icon Maker 

Greg's Buttons 

iContraption 

Invisible Clock 

® Kingyo 

Menu Bar Pattern _ _........ 

Description 

Allows you to substitute each of the five system 
cursors (1-beam, crosshair, crossbar, w ristwatch, and 
arrow) w ith static or animated color cursors 
guaranteed to be much more entertaining. 

A hilarious spoof on the incoherent mumblings of a 
certain American folk singer, DylanTalk attempts to 
pronounce the text in modal dialog and alert boxes, as 
well as the titles o f controls w hen tl1ey are cl icked. It's 
so stupid, it's good. 
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Makes impressive-looking custom icons for folders 67 
w ith a drag-and-drop interface that couldn't he simpler. 

Gives your Mac a complete make-over, altering the 89 
default font, buttons, and background colors, among 
other things. 

A full-blown icon editor that can also be used to move 55 
icon resources from one file to another. Comes w ith 
dozens upon dozens of icons. 

Audibly announces the time in a pleasant, female 9 
voice. Then this unpaid secretaty hangs out in the 
background. announcing the time between the hours 
you choose: every hour, half-hour, or quarter-hour as 
you prefer. 

Tf you 've always wanted a pet but are too self­
involved to give it the love and food it craves, Kingyo 
is just w hat the vet ordered: a cute animated ca rtoon 
fish that swims around your screen. 

Paints tJ1e menu bar w ith incredibly cool desktop 
patterns as large as 32 x 64 pixels and containing 
up to 256 colors, including Wallpaper patterns. 
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